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Introduction to the Auditing and Reporting Module (ARM) 
These topics provide the procedures for configuring and using the Auditing and Reporting module (ARM) 
with EFT Server. 

The Auditing and Reporting Module (ARM) captures the transactions passing through EFT Server and 
provides an interface in the administration interface where you can use preconfigured reports or create 
your own custom reports to query, filter, and view transaction data. Data is stored in a relational database 
and can be analyzed in real time. 

The ARM comes with a number of preconfigured reports to help you start analyzing data right away. The 
built-in reports were designed to respond to the most common data analysis requests. 

Auditing and Reporting Module Interface 
The Report tab of the administration interface is the interface for the Auditing and Reporting module 
(ARM). 

 
• When you click the Report tab in the left pane, the right pane displays the report. Using the 

controls in the right pane, you can view, edit, print, and save the report or create a new report. 

• When you define a new report template, it appears in the Custom Reports node of the tree. 

• Refer to Generating a Report, Managing Reports, and Custom Reports for details of running, 
managing, and defining reports. 

• Refer to Descriptions of Preconfigured Reports for descriptions of the report templates in the 
Globalscape Reports node of the tree. 
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Installing and Configuring the Auditing and Reporting 
Module 
The module is normally installed and configured when you install EFT Server. If you did not install it when 
you installed EFT Server, you can run the installer again, choose Modify, and then select the Auditing 
and Reporting check box. (Leave the EFT Server and EFT Admin Interface check boxes selected; 
clearing the check boxes will uninstall them.) 

Refer to "Installing EFT Server, Administrator, and Modules" in the EFT Server User Guide for the 
procedure for installing ARM. 

Auditing and Reporting Module (ARM) Requirements 

• Microsoft® ActiveX Data Objects (ADO) 
• Microsoft SQL Server 2008 R2 Native Client is installed automatically, regardless of whether SQL 

Server will be used (so that ADO will work with IPv6). 
• 3GB minimum hard drive space for the initial database size. Space requirements for transactions 

depend on estimated EFT Server activity, number of users, installed modules. A general estimate 
is 3MB to 5 MB per 1000 files uploaded. 

• PDF-viewing software (such as Adobe Reader) to view PDFs of reports. 
• Microsoft .NET Framework 4.0, for ARM upgrades  
• Access to a SQL Server or an Oracle database. 

o The installer includes SQL Server 2008 R2 Express for both 32- and 64-bit operating 
systems (intended for evaluation purposes only). For SQL Server system requirements, 
refer to http://www.microsoft.com/sqlserver/en/us/learning-center/resources.aspx. EFT 
Server is supported with the following SQL Server versions: 

 SQL Server 2008 R2 Express 
 SQL Server 2008 R2 
 SQL Server 2012 

o Oracle is supported for use with EFT Server Enterprise only; refer to Oracle's 
documentation regarding Oracle system requirements. Be sure to reboot after you install 
the Oracle Data Access Components (ODAC). You need to use the 32-bit ODAC, even if 
EFT Server Enterprise is installed on a 64-bit operating system. EFT Server Enterprise is 
supported with the following Oracle versions: 

 Oracle Database 11g Release 1: 11.1.0.6–11.1.0.7 (patchset as of September 
2008) 

 Oracle Database 11g Release 2: 11.2.0.1–11.2.0.3 (patchset as of September 
2011) 

o A good database maintenance plan is important to keeping space requirements to a 
minimum (aging/archiving/warehousing/truncating old data). 

o For better database performance, follow the standard SQL/Oracle tuning guidelines in 
their user documentation. See also Purging Data from the Database. 

o If you are using SQL Server 2008 Developer and Enterprise editions for your EFT Server 
database, refer to the MSDN article Creating Compressed Tables and Indexes. 

 

 

For EFT Server to connect to any database, the proper drivers need to be installed on the EFT 
Server computer. If the right client-side software (driver) is installed on the EFT Server computer, 
the Advanced Workflow Engine can make the database connection string to get to that database. 
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Installation and configuration of the module consists of: 

1. Running the EFT Server installer. The Auditing and Reporting module is normally installed and 
configured when you install EFT Server. If you did not install it when you installed EFT Server, 
you can run the installer again and choose Modify. On the ARM page of the installer, click 
Configure Auditing and Reporting. (Refer to "Installing the Server, Administrator, and Modules" 
in the EFT Server User Guide.) 

 

During installation, EFT Server needs full DB Owner access to the auditing database to set 
up the schema. During updates or upgrades, EFT Server needs full DB Owner access to 
update the schema. Once it is set up, EFT Server only needs to be able to read, write, and 
execute stored procedures. 
When upgrading to EFT Server v6.4.x, if you upgrade the ARM database with the installer, 
the default schema name is changed to dbo. 

2. Activating the software with a serial number that includes ARM 

3. Enabling EFT Server to record data 

How does EFT Server know which TCP/IP port it should use to connect to SQL 
Server? 
When the SQL Server browser service (installed with SQL Server) starts up, it searches the registry for 
any "named instances" of SQL Server and which TCP ports they're listening on. When a client wants to 
connect to a named instance, it asks the browser service (on UDP port 1434) on which TCP/IP port is that 
instance listening. This is how Microsoft implemented support for multiple instances of SQL Server on the 
same computer. The default instance listens on TCP port 1433. If you have a named instance, the TCP 
port is dynamically configured. 

This is standard SQL Server functionality and doesn't require special port syntax in the EFT Server 
connection string or host name. It's all abstracted by the API used, which looks at the host string and 
figures out whether you're trying to connect to a named instance or a default instance (by determining 
whether host\instance or just host was specified). 

The SQL Server TCP settings are stored in: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 
Server\MSSQL10.<InstanceName>\MSSQLServer\SuperSocketNetLib\TCP\ 

For details of how to view/change the TCP information in the SQL Server Configuration Manager, refer to 
the following MSDN article: http://msdn.microsoft.com/en-us/library/ms177440%28SQL.90%29.aspx 

Refer to the following Microsoft topics for more information: 

• http://support.microsoft.com/kb/287932 

• http://msdn.microsoft.com/en-us/library/ms175483.aspx 

• http://msdn.microsoft.com/en-us/library/ms181087.aspx 

EFT Server Database Utility 
A command line utility is included in the installer that is capable of performing various database-related 
tasks. This same utility is used by the EFT Server installer to handle upgrades of existing databases. 
Typically, all common database tasks are handled by the EFT Server installer. However, on occasion it 
may be useful to use the command-line utility to verify the status of a database or perform an upgrade 
independent of the EFT Server installation process. 

The database utility (DBUtility.exe) is included as part of the core EFT Server installation. Once installed it 
is located in the "DBUtility" sub-directory of the EFT Server program files installation directory. Typically 
this will be C:\Program Files (x86)\Globalscape\EFT Server Enterprise\DBUtility. 
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Requirements 

• The utility requires the .NET Framework 4 (Full version) 

• When operating against an Oracle database, the utility requires the 32-bit version of the Oracle 
Data Access Components (ODAC) 

Capabilities 

The database utility is capable of performing the following tasks: 

• Check the version of the database to see if it is up to date. This may be used to see if an upgrade 
must be performed on a database before it is ready to be used the EFT Server application. 

• Generate an SQL script that may be used to create a new database schema (tables, views, etc.) 
manually within an existing database. 

• Generate an SQL script that may be used to upgrade an existing database schema manually. 

• Analyze an existing database prior to performing an upgrade. The analysis will verify 
prerequisites, display information about the database, and display the SQL that will be used to 
upgrade the database. 

• Upgrade an existing database schema to the latest version. 

Logging 

The utility is capable of outputting various levels of information ranging from errors to debug/trace level 
information. 

By default, the utility will output errors, warnings, and informational messages to the command window. If 
the "-verbose" command line parameter is specified, the utility will also output more fined-grained 
debug/trace level messages to the command window. 

The utility may also optionally output to a log file as specified using the "-logfile" command line option. 
The output to the log file will include all levels of messages from errors to debug/trace level information. 

SQL Scripts 

The utility requires the presence of various SQL Scripts located in database-specific subdirectories to 
perform its actions. These subdirectories contain scripts such as: 

• create_* - scripts used for creating new, clean database schemas for use by the EFT Server 
application 

• Purge* - scripts that may be used for purging data from the database 

• *ODBC - scripts that may be used to create the necessary tables to use an ODBC data source for 
user authentication 

• upgrade_* - upgrade scripts for upgrading various versions of the database 

By default, the utility will look for the "SQL Server" and "Oracle" directories under its current working 
directory. During installation of the Database utility, these script directories will be created under the 
<InstallDir>\DBUtility directory, so the scripts will be available to the utility. 

If the utility is unable to locate these subdirectories, it will also attempt to consult the registry for the EFT 
Server "AppData" path and then look for the subdirectories under that location. 

Additionally, the user may specify an alternate parent directory using the "-scripts" command line 
parameter. 
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Usage 

The database utility is a command line utility and may be executed by opening a Windows Command 
Prompt and navigating to the "DBUtility" subdirectory of the EFT Server installation folder (e.g., 
C:\Program Files (x86)\Globalscape\EFT Server Enterprise\DBUtility) and running the command 
"DBUtility.exe." 

Help 

The utility includes built-in help documentation. Additionally, the utility will provide feedback on incorrect 
or missing command line parameters. 

The built-in help documentation for the utility may be accessed using the command: 
DBUtility.exe -help 

More detailed help for the various top-level actions may be accessed using the command: 
DBUtility.exe -help -action <Action ID> 

Where <Action ID> is one of: 

• CheckVersion - checks the version of the database to see if it is up to date 

• CreateScript - generates a SQL script that may be used to manually create a new database 
schema 

• UpgradePreview - used prior to upgrading a database. This action will generate and display 
useful pre-upgrade information as well as the actual SQL that will be used to upgrade the 
database 

• UpgradeSchema - upgrades the database, if needed 

• UpgradeScript - generates a script that may be used to manually upgrade a database 

Examples 

Example executions for each of the actions supported by the utility may be viewed in the command line 
help for each action. 

DBUtility Command Line Parameters 
The following section describes each of the command line parameters for the utility. Depending on the 
action performed, only a subset of the parameters will be applicable or required. 

For the command line parameters that accept a value, the value should be enclosed in double-quotes if 
the value contains spaces. For example,  

-logfile="C:\My Logs\MyLogFile.txt" 

Parameter Definitions 

• -help 
o Description: Display help on the command line. Refer to the "Help" section above for 

additional information. 
• -logfile=<file> 

o Description: When specified the utility will log output of the execution to the specified log 
file. 

o Default: None 
o Example:  

-logfile="C:\My Logs\MyLogFile.txt" 
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• -optionsfile=<file> 
o Description: When specified the utility will load command line parameters from the file. 

The file should specify parameters in a "parameter=value" pair with one pair specified per 
line. Parameters specified on the command line override parameters specified in the file. 

o Default: None 
o Example:  

-optionsfile="C:\My Scripts\MyOptionsFile.txt" 

• -scriptfile=<file> 
o Description: For actions that generate output SQL scripts this parameter defines the file 

to which the script should be written. 
o Default: None 
o Example:  

-scriptfile="C:\My Scripts\MySQLScript.sql" 

• -errorfile=<file> 
o Description: When specified the utility will log terminal errors to the specified file. Mainly 

used for error handling when the utility is called by the EFT Server installer. 
o Default: None 
o Example:  

-errorfile="C:\My Scripts\MyErrorFile.txt" 

• - resultfile=<file> 
o Description: When specified the utility will output result status codes for the execution to 

the file. Mainly used for state handling when the utility is called by the EFT Server 
installer. 

o Default: None 
o Example:  

=resultfile="C:\My Scripts\MyResultFile.txt" 

• -pause 
o Description: When specified the utility will pause at the end of the execution. Useful when 

executing the utility through a shortcut to keep the console window from closing before 
the user has a chance to review the results. 

o Default: None 
• -verbose 

o Description: When specified the utility will output additional debug level logging. 
o Default: None 

• -action=<id> 
o Description: Specifies the overall action to be performed by the utility. 
o Valid values: 

 CheckVersion - checks the version of the database to see if it is up to date 
 CreateScript - generates a SQL script that may be used to manually create a 

new database schema 
 UpgradePreview - used prior to upgrading a database. This action will generate 

and display useful pre-upgrade information as well as the actual SQL that will be 
used to upgrade the database 

 UpgradeSchema - upgrades the database, if needed 
 UpgradeScript - generates a script that may be used to manually upgrade a 

database 
o Default: None 
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o Example:  
-action=UpgradeSchema 

• -type=<type> 
o Description: The dialect of the database. 
o Valid values: 

 SQLServer - a SQL Server/SQL Server Express database 
 Oracle - an Oracle database 

o Default: None 
o Example:  

-type=SQLServer 

• -server=<server> 
o Description: The database server host or IP address 
o Default: None 
o Example:  

-server="Jupiter" 

• -port=<port> 
o Description: The listener port for the database on the database server/host. 
o Default: None 
o Example: 

-port=1433 

• -instance=<instance> 
o Description: The database server instance name. 
o Default: None 
o Example: 

-instance="MSSQLSERVER" 

• -database=<database> 
o Description: The name of the database. 
o Default: None 
o Example:  

-database="GLOBALSCAPE" 

• -timeout=<timeout> 
o Description: The timeout, in seconds, to continue trying to connect to the database. A 

value of 0 causes the utility to wait indefinitely and should be used with caution. 
o Default: 30 seconds 
o Example:  

-timeout=5 

• -auth=<auth> 
o Description: The type of authentication to use when connecting to a SQL Server 

database. 
o Valid values: 

 SQLServer - Use SQL Server authentication which requires specification of the 
username and password. 

 Windows - Use Windows authentication which will use the currently logged in 
user account. 

o Default: None 
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o Example:  
-auth=SQLServer 

• -user=<user> 
o Description: The login name to use when connecting to the database. 
o Default: None 
o Example:  

-user="eftdbuser" 

• -pass=<pass> 
o Description: The password to use when connecting to the database. 
o Default: None 
o Example:  

-pass=“3qym9NCebHDJ” 

• -scripts=<dir> 
o Description: Parent directory containing the SQL Server and Oracle SQL Scripts 

subdirectories. Refer to the "SQL Scripts" section above for additional information. 
o Default: Refer to the "SQL Scripts" section above for additional information. 
o Example:  

-scripts="C:\ProgramData\Globalscape\EFT Server Enterprise" 

Advanced Parameter Definitions 

The following parameters are typically reserved for use by the EFT Server installer and will normally not 
be useful to end users. However, they are documented here for completeness. 

• -conn=<connection string> 
o Description: When specified this string will be used as the full connection string to the 

database rather than constructing the string based on the distinct parts. 
o Default: None 
o Example:  

-conn="Data 
Source=(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=mth-
oracle)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=orastart)));Persist 
Security Info=true;User Id=eftdbuser;Password=3qym9NCebHDJ" 

• -app=<application name> 
o Description: The application name to present to the database for use when identifying 

connections. 
o Default: None 
o Example:  

-app="EFT Server Database Utility" 

• -installerdir=<directory> 
o Description: The directory containing the EFT Server Installer. May be used during some 

upgrades for accessing or storing additional files. 
o Default: None 
o Example:  

-installerdir="C:\Users\Administrator\AppData\Local\Temp\nsdB57C.tmp" 

• -installationdir=<directory> 
o Description: The directory where EFT Server is installed or will be installed. May be used 

during some upgrades for accessing or storing additional files. 
o Default: None 

12 



Auditing and Reporting Module (ARM) 

o Example:  
-installationdir="C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise" 

• -appdatadir=<dir> 
o Description: The directory that will be used for the EFT Server application data. May be 

used during some upgrades for accessing or storing additional files. 
o Default: None 
o Example:  

-appdatadir="C:\ProgramData\Globalscape\EFT Server Enterprise" 

• -backupdir=<dir> 
o Description: The directory in which to store backup data. May be used during some 

upgrades. 
o Default: None 
o Example:  

-backupdir="C:\ProgramData\Globalscape\EFT Server Enterprise\Backup" 

Database User Account Privileges 
The database user account used by EFT Server must have certain privileges within the database for the 
application to function correctly. Additionally, a different set of privileges are needed for Installation, 
Upgrade, and Runtime, as described below. 

Installation—When creating a new database, the EFT Server installer is capable of creating the 
database user account for you. Alternatively, you may create the database user account ahead of time. 
Either way, the EFT Server database user account must have certain privileges during the creation 
process. Once the creation process is complete, the privileges may be reduced to those necessary for 
runtime operation. (Refer to Runtime below.) The following privileges, or their equivalents, are required 
during the creation process: 

• SQL Server—The database user account must have the "db_owner" database role membership. 

• Oracle—The database user account must have the following privileges: 

• CREATE SESSION 
• CREATE TABLE 
• CREATE TRIGGER 
• CREATE SEQUENCE 
• CREATE PROCEDURE 
• CREATE VIEW 

Upgrade—When upgrading the ARM database, either through the EFT Server Installer or the Database 
Utility (DBUtility.exe), you should use the EFT Server database user account to connect to the database 
to perform the upgrade. The upgrade process may temporarily require that additional privileges be 
temporarily given to the EFT Server database user account. The actual set of privileges depends on the 
version of the database schema being upgraded. Before upgrading the database, the EFT Server 
Installer will perform an analysis of the database. Additionally, the "UpgradePreview" action may be used 
with the Database Utility to perform the analysis. Part of this analysis will verify that the database user 
account possesses the necessary privileges to perform the upgrade. The analysis results will display any 
privileges that the account is lacking. You will need to grant the appropriate privileges to the account 
temporarily before proceeding with the upgrade. These privileges may be revoked once the upgrade 
process is complete. Refer to the Runtime section below for the privileges required during subsequent 
operation of EFT Server. To minimize the chance of encountering missing privileges, you should grant the 
privileges described in Installation, above, before performing the upgrade preview analysis. 
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Runtime—During normal operations, the EFT Server only manipulates the data within the database while 
auditing, and so requires less powerful privileges. EFT Server does not modify the database schema 
during normal operation. If you want to lock down the EFT Server database user accounts during normal 
operation, ensure that the following minimal privileges, or their equivalents, are granted to the account: 

• SQL Server—When operating against SQL Server, the EFT Server database user account only 
needs to be able to read data, write data, and execute stored procedures. The following 
permissions are required during normal operation: 

• CONNECT 
• DELETE 
• EXECUTE 
• INSERT 
• SELECT 
• UPDATE 

• Oracle—During normal operation, the EFT Server database operates only within its own schema. 
Additionally, it has no need to create objects during runtime. Only the following privilege is 
required during normal operations: 

• CREATE SESSION 

Activating the Auditing and Reporting Module 
The Auditing and Reporting Module (ARM) is an add-on to EFT Server that comes with a unique 
activation serial number. 

• If you have purchased EFT Server with ARM and have your serial number, follow the normal 
activation process. 

• If you are upgrading, follow the upgrade process. 

Upgrading the EFT Server Database 
This introduction describes in general how an EFT Server database upgrade works.  

Before upgrading the ARM database for EFT Server v6.5, please refer to Upgrading the EFT Server 
ARM Database for the 6.5 Release, below. 

A Database Utility (DBUtility.exe) is used to upgrade the database, when applicable. You have the 
option of either upgrading the database during the upgrade process within the EFT Server Installer or 
choose to upgrade the database "out of band" later using the Database Utility. Because the EFT Server 
installer uses the same Database Utility internally to perform the upgrade, the methods are synonymous. 

As part of this new approach to upgrading the ARM database, the database schema maintains an 
independent version number. This version is used to determine if the database schema and data require 
an upgrade across various releases of the EFT Server application. This version number is maintained in a 
new table called "TBL_SCHEMA_VERSION." This new table is created as part of the initial ARM upgrade 
process when upgrading EFT Server. 

During the upgrade, you will be prompted to provide the user credentials that should be used when 
connecting to the database. You must provide the credentials for the EFT Server database user 
account, as opposed to the super-user accounts such as "sa" or "sys", because the upgrade 
process assumes it is operating as the database account that owns the schema to be upgraded. (Refer to 
Database User Account Privileges > Upgrade for information on the required database user account 
privileges necessary to successfully upgrade.) 
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When upgrading from within the EFT Server installation process, the installer will analyze the database 
prior to performing the actual upgrade. The results of this analysis are displayed in an upgrade preview 
page of the installer. Administrators are urged to read the results carefully prior to continuing with the 
upgrade. (EFT Server's upgrader does not check the database for fragmentation.) 

The analysis step will determine whether the database requires an upgrade by examining the version 
number in the new version table. Across many builds and releases of the EFT Server application, the 
ARM database may not require any changes. As such, the version number for the database may not 
change as often as the EFT Server version. If the database does not require an upgrade, then the 
installer will state this and essentially skip the ARM upgrade process. 

As with the database upgrade, the database analysis process used in the EFT Server installer is actually 
performed by the Database Utility and is equivalent to running the utility with the "-action=PreviewUpgrade" 
command line option. In addition to checking the database version number, the installer/utility will also 
check for various prerequisites needed to perform the upgrade. Prerequisites that have been met will be 
displayed with a "PASS" status. Any prerequisites that have not been met will be displayed with a "FAIL" or 
"WARN" status. These issues should be researched and rectified prior to proceeding with the upgrade. 

Recommendations are provided along with any failed prerequisites suggesting how to resolve the issue. 
After remedying any errors, you can run the analysis again by clicking Reanalyze. 

The analysis will also display information about the database such as the approximate size of the user 
data as well as the age of the user data within the database. Additionally, the SQL script that will 
subsequently be used to perform the actual upgrade will be displayed. 

You may decide to upgrade the database later. If so, you can retain the upgrade script by clicking View to 
open the database analysis results in a text editor and then save to a file of your choosing. 

Alternatively, you can run the EFT Server installer in maintenance mode or run the Database Utility using 
the "-action=UpgradeSchema" option to upgrade the database another time. 

Upgrading the EFT Server ARM Database for the 6.5 Release 

For EFT Server version 6.5, existing ARM databases must be modified to allow for storage and retrieval 
of Unicode data. This upgrade process is much more significant with respect to time and storage space 
than past upgrades.  

Please refer to the following information before upgrading the ARM database. An upgrade checklist is 
also provided below. 

User Account Permission/Privilege Requirements 
When upgrading the ARM Database, either through the EFT Server Installer or the Database Utility, you 
should use the EFT Database user account to connect to the database to perform the upgrade. This is as 
opposed to using one of the more privileged system accounts such as the "sa" account on SQL Server or 
the "sys" or "system" accounts on Oracle. 

For additional information related to database user account privileges refer to Database User Account 
Privileges. 

SQL Server 
The user account used to upgrade the database should have the "db_owner" privilege. This is the default 
for the user account created for, and used by, the EFT Server. As such, no action is required on your part 
prior to upgrading. 
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Oracle 
As of EFT Server version 6.5, the ARM module makes use of database views. In previous releases, the 
database user account created for use by the EFT Server was not granted the ability to create views. As 
such, prior to upgrading an Oracle ARM database, you must grant this privilege to the EFT Server 
database user account manually. This is done by granting the "CREATE VIEW" privilege to the account 
using a more privileged account such as the "sys" or "system" account. 

One method of granting the privilege is to connect to the database using the Oracle command line "SQL 
Plus" utility. On the computer where Oracle is installed, launch the SQL Plus utility: 

• Click the SQL Plus Start menu shortcut (e.g., Start Menu > All Programs > Oracle - 
OraDb11g_home1 > Application Development > SQL Plus) 

• If the utility is available on the system path, then open a Windows command prompt (e.g., Start > 
Run > cmd.exe), type sqlplus at the command prompt, and then press ENTER. 

Once SQL Plus has started, you will be prompted for login credentials. Connect using a privileged 
account such as "sys" or "system". Be aware that when connecting as the "sys" account you must provide 
the "as sysdba" option; for example: 

sys as sysdba 

 
Complete the login process by providing the password. 

Use the following command to grant the "CREATE VIEW" privilege to the EFT Server database user 
account:  

GRANT CREATE VIEW TO <User>; 

Where <User> is the name of the EFT Server database user account. For example: 
GRANT CREATE VIEW TO EFTDBUSER; 
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Exit the SQL Plus tool by typing Exit and pressing ENTER. 

Time Requirements 
The EFT Server v6.5 ARM upgrade process can take significantly longer than past upgrades. The time it 
takes to perform the upgrade depends both on the size of the database and the performance 
characteristics of the computer on which the database resides. 

Our internal testing has shown that the database upgrade can take as little as 15 minutes for a 
moderately sized database of 5GB, up to 3 hours or longer for larger databases of 30GB or more. 
Because the time it takes to perform the upgrade is greatly dependent on CPU and Disk I/O speed, it is 
difficult to provide an exact time for any given situation.  

For additional information related to upgrading large databases please refer to Upgrading Large 
Databases. 

Refer to Upgrade Paths below for a discussion of the available upgrade paths that may be used to 
minimize down time. 

Disk Space Requirements 
The size of the database will grow as part of the upgrade because of changes in the data types used for 
storing character-based data. 

Our internal testing indicates that, on average, the size of user data in the database will increase by 
approximately 31% as part of the upgrade process. For example, if your database consumes 10GB 
before upgrading, then it will use approximately 13GB after upgrading. 

If disk space is limited, you should consider purging older data from the database prior to upgrading. For 
information on purging data from the ARM database, refer to Purging Data from the Database. 

For additional information related to upgrading large databases, refer to Upgrading Large Databases. 

SQL Server Considerations 
If you have limited disk space and are using SQL Server, it may be possible to reduce the size of the 
database prior to proceeding with the upgrade. This may be accomplished by "shrinking" the database, 
which will reclaim unused space.  

For information and considerations on shrinking a SQL Server database, please refer to the Shrink a 
Database topic on the Microsoft Developer Network site. 

During the upgrade process, the increase in size of the user data will be reflected by an increase in the 
size of the database's MDF file by approximately 31%.  

17 

http://msdn.microsoft.com/en-us/library/ms189035.aspx
http://msdn.microsoft.com/en-us/library/ms189035.aspx


Auditing and Reporting Module User Guide 

Additionally, the database transaction log file, the LDF file, may temporarily grow in size. In testing, the 
LDF file typically increased to between 1% and 3% of the starting size of the corresponding MDF file. For 
example, if your MDF file is 10GB in size, then the LDF file could be expected to grow temporarily to 
approximately 300 MB in size. 

Oracle Considerations 
When upgrading Oracle databases you must ensure that not only is the appropriate amount of disk space 
available, but that the USERS tablespace is capable of growing to accommodate the additional storage 
requirements. You may consider allowing the USERS tablespace data files to auto extend during the 
upgrade process. Additionally it may be necessary or desirable to create additional data files for use with 
the USERS tablespace. 

Upgrade Paths 
Depending on the size of the ARM database and the time constraints on performing the upgrade of EFT 
Server, you may choose to consider alternate methods of upgrading the ARM database. Described below 
are pros and cons of two alternate methods of upgrading the database, when each method is appropriate, 
and how to perform the upgrade using each method. 

Method 1: During the EFT Server upgrade 

This is the typical method of upgrading the ARM database. When running the EFT Server installer, you 
can upgrade the ARM database as part of the full upgrade process. 

Pros 

Simplest method, requiring minimal manual steps 

Cons 

The EFT Server will be unavailable for the time it takes to perform the entire upgrade 

Appropriate When 

• The ARM database is relatively small or the computer running the database is sufficiently 
powerful 

• The ARM database is large, but a few hours of downtime is acceptable 

How to Perform 

• When upgrading using the EFT Server installer, on the EFT Server Enterprise Auditing and 
Reporting database configuration page of the wizard, click Configure Auditing and 
Reporting and proceed accordingly. 

Method 2: Out of band 

With this method, EFT Server may be upgraded independent of the ARM Database. Specifically, you 
would upgrade the EFT Server using the EFT Server installer, but choose to skip upgrading the ARM 
database at that time. Once the EFT Server application has been upgraded, it may be restarted and will 
thus be available to service end users. During the time that the ARM Database has not yet been 
upgraded, the EFT Server application can temporarily store audit information to disk. 

You can then upgrade the ARM database using the Database Utility. Once the upgrade has completed, 
the EFT Server will then be able to reconnect to the database as normal. 

Pros 

• Allows for minimal downtime of the main EFT Server facilities 

Cons 

• EFT Server Reporting capabilities will be temporarily unavailable 

• Requires additional steps to perform the upgrade 
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Appropriate When 

• Upgrading very large database and the necessary downtime of the main EFT Server facilities is 
unacceptable 

How to Perform 

• Prior to starting the upgrade process, configure the EFT Server application to audit to a folder 
while disconnected from the database. Refer to Audit Database Settings for information about this 
functionality. 

• Upgrade the EFT Server application using the EFT Server installer. On the EFT Server 
Enterprise Auditing and Reporting database configuration page of the installer, click Skip 
Auditing and Reporting configuration and proceed accordingly. 

• After EFT Server has been upgraded, restart the EFT Server service. 

• Upgrade the ARM database using the Database Utility. 

o First, perform a preview upgrade using the "-action=UpgradePreview" option of the utility. 
This will verify that the appropriate requirements for upgrading the database have been 
met. 

o After the requirements have been verified, use the "-action=UpgradeSchema" option to 
perform the actual upgrade. Optionally you may instead generate an upgrade script using 
the "-action=UpgradeScript" option and manually upgrade the database using vendor 
tools such as SQL Server Development Studio or SQL Plus. 

o Refer to EFT Server Database Utility for additional information. 

ARM Upgrade Checklist 
SQL Server 

 Ensure a current backup of the database is available 

 If necessary/desired, purge older data from the database 

 Ensure the necessary disk space is available to perform the upgrade 

 Remove any custom schema modifications made to the database 

 Follow the desired upgrade method 

 Recreate any custom schema modifications 

Oracle 

 Ensure a current backup of the database is available 

 If necessary/desired, purge older data from the database 

 Ensure the necessary disk space is available to perform the upgrade 

 Ensure the USERS tablespace and associated data files are configured to allow for the 
necessary data growth 

 Remove any custom schema modifications made to the database 

 Grant the "CREATE VIEW" privilege to the EFT Server database user account 

 Follow the desired upgrade method 

 Recreate any custom schema modifications 
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Upgrading Large Databases 
The majority of the modifications performed on the ARM database when upgraded take only minutes to 
complete. Occasionally, more modifications are needed when upgrading the database schema. These 
upgrades may take a long time, especially when they require modifications to the data stored within the 
database. As such, the time it takes to perform the upgrade may increase with the size of the database. 
Depending on the size of the database, such upgrades take hours instead of minutes. 

The database upgrade preview process includes the age of the oldest data in the database as well as a 
rough estimate of the database size. Administrators should use this data to assess the current state of the 
database when deciding how and when to proceed with the database upgrade. 

Administrators of large databases should consider the following options to ensure a smooth upgrade 
process: 

• Administrators should consider purging older data from the database prior to upgrading. (Refer to 
Purging Data from the Database for details.) 

• The database should be backed up prior to any upgrade to allow for quick recovery in case of 
errors. 

• Administrators should consider making a copy of the ARM database and performing a test 
upgrade of the database. The script necessary to perform the test upgrade may be obtained by 
proceeding through the EFT Server Installer's upgrade process and choosing to upgrade the 
ARM Database. When prompted for the database credentials, specify the test database 
credentials. On the Upgrade Preview page of the installer, click View, save a copy of the 
upgrade script, and then cancel the EFT Server installer. You may now use the SQL script to 
upgrade the database manually. Alternatively, you can install a clean copy of EFT Server on 
another computer and use the Database Utility (DBUtility.exe) to perform the test upgrade. 

• Administrators should consider upgrading the database "out of band" from upgrading the EFT 
Server installation. This may be done by skipping the ARM database upgrade in the EFT Server 
Installer when performing the initial EFT Server upgrade. The updated version of the EFT Server 
will temporarily audit database transactions to disk until the ARM database has been upgraded.  

To perform an out-of-band upgrade of ARM 

1. If desired, prior to upgrading the EFT Server, enable the ARM audit-to-folder feature. 

2. Use the installer to upgrade the EFT Server, but skip the ARM upgrade process, then do 
one of the following: 

• Rerun the installer in maintenance mode later to upgrade the ARM database. 

• Use the Database Utility (DBUtility.exe) to perform the upgrade. 

• Manually upgrade using the SQL scripts generated by DBUtility.exe. 

3. After the ARM database has been upgraded, click Reconnect in the EFT Server 
administration interface, on the Server's Logs tab to instruct EFT Server to connect to the 
upgraded database. EFT Server will then import any database transactions that were 
audited to disk in the interim. 

Manually Creating the ARM Database in SQL Server 
This procedure should only be used if you have not already created the ARM database using the EFT 
Server installer. All tables will be created in the schema regardless of which features and/or modules are 
actually in use. 
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The following instructions use the SQL Server Management Studio application from Microsoft. Optionally, 
users may prefer to use command line tools such as oSQL to create the database. The oSQL utility 
allows you to execute Transact-SQL statements, system procedures, and scripts for creating and 
maintaining the database. For additional information on the oSQL utility, including common script 
samples, refer to osql Utility on microsoft.com. 

First you will create the database, then create the database user account, create the schema, configure 
EFT Server to connect to the database, and then test the connection. 

Create the Database 
To create the database 

1. Using the SQL Server Management Studio application, connect to the SQL Server instance using 
an account that has the privileges necessary to create user accounts and databases. Typically 
the "sa" account will suffice. 

2. In the left pane, right-click Databases, then click New Database. 

 
3. The New Database dialog box appears. Name the database eftdb. (You can use a different 

database name, but be sure to use the name you chose throughout this procedure.) 

4. In the Database files table, change the Initial size value to 10 MB for the eftdb logical name 
(first row). Leave the eftdb_log row as is. The dialog box should resemble the following screen 
shot: 
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5. Click OK to finalize creation of the database. 

Create the Database User Account 

 

During installation, EFT Server needs full DB Owner access to the auditing database to set up the 
schema. During updates or upgrades, EFT Server needs full DB Owner access to update the 
schema. Once it is set up, EFT Server only needs to be able to read, write, and execute stored 
procedures. For more information on the required database privileges please refer to Database User 
Account Privileges. 

To create the database user account 

1. Using the SQL Server Management Studio application, connect to the SQL Server instance using 
an account that has the privilege to create user accounts and databases. Typically the "sa" 
account will suffice. 

2. In the left hand pane, expand the Security node, right-click Logins, and then click New Login. 
The New Login dialog box appears. 

 
3. Create a new user called eftuser and then click SQL Server Authentication. (You can use a 

different user name, but be sure to use the name you chose throughout the procedure.) 
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If SQL Server Authentication is not available as a choice, verify that the SQL Server has 
been configured to support mixed mode. 

4. In the Password and Confirm password boxes, provide a complex password consisting of an 
alphanumeric and symbol mix of at least 8 characters. 

5. Ensure the Enforce Password Policy check box is selected. 

6. Ensure the Enforce password expiration check box is not selected. (Optionally, you can enable 
this setting, but be aware that the eftuser account password will need to be changed periodically 
to prevent expiration.) 

7. Ensure the User must change password at next login check box is not selected. 

8. Set the Default database to the eftdb database created earlier. 

9. In Default language, click the list to select your language or leave it set to the <default> setting. 
The dialog box should resemble the following screen shot: 

 
10. Select the User Mapping node in the left pane. 

11. In the Users mapped to this login table, locate the entry for the eftdb database created earlier. 

12. Select the check box in the Map column for the eftdb row and set the Default Schema to dbo. 

13. While the eftdb row is selected, in the Database role membership for table, select the 
dbo_owner check box. The dialog box should now resemble the following screen shot: 
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14. Click OK to finalize the user creation. 

Create the Schema 
During installation of the EFT Server, the installer will place a set of database creation SQL scripts in the 
GlobalSCAPE\EFT Server Enterprise\SQL Server subfolder of the system Program Data folder. 
(Typically, C:\ProgramData\GlobalSCAPE\EFT Server Enterprise\SQL Server.)  The database 
creation scripts use the "create_#_" filename prefix. The # in the filename represents the order in which 
each script must be executed. 

 
You will use these scripts to create the schema using the procedure below. 

To create the schema 

1. Using the SQL Server Management Studio application, connect to the SQL Server instance using 
an account that has the privilege to create user accounts and databases. Typically the "sa" 
account will suffice. 

2. In the left pane, expand the Databases node, right-click on the eftdb node, and click New Query. 
A blank screen appears in the right pane in which you can type in a SQL query. 
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3. Execute each creation script in the specified order by copying/pasting the script file contents into 
the left pane and clicking Execute. A message appears each time you click Execute indicating 
whether the query was able to complete successfully. 

4. In the left pane, expand Databases, then eftdb, then Tables. Verify that the database has 
populated correctly. (The tables defined in the script should have been created.) 

Configure EFT Server 
To configure EFT Server to connect to the newly created database 

• Refer to Audit Database Settings. 

Test Your Connection 
To test the connection 

1. Create a test connection with your FTP client to EFT Server and upload and download a few files. 

2. In SQL Server Management Studio select the dbo.tbl_ProtocolCommands table under the 
eftdb database icon. It should return several rows with the commands issued by your client from 
the test connection. 

3. You can now pull reports directly from EFT Server against data audited to SQL Server. 

 

If you are running the administration interface, you must have an entry in that system's DNS for the 
name of the SQL Server, otherwise the administration interface will not be able to connect to the 
SQL Server when attempting to pull reports. 

Manually Creating the ARM Database in Oracle 
This procedure should only be used if you have not already created the ARM database using the EFT 
Server installer. 

All tables will be created in the schema regardless of which features and/or modules are actually in use. 

The following instructions assume you have already installed the Oracle database software and that an 
Oracle database is available. These instructions will make us of the Oracle SQLPlus command line utility 
to execute SQL against the Oracle database. Optionally, users may use an alternate utility of their 
preference. 

Create the Database User Account 
During installation and upgrade, EFT Server needs creation privileges within the database. Once it is set 
up, EFT Server only needs to be able to read, write, and execute stored procedures. For the specific set 
of privileges required, please refer to Database User Account Privileges. 

To create the database user account 

1. Using SQLPlus connect to the Oracle database using an account that has the privileges 
necessary to create user accounts and grant privileges. Typically the "sys" or "system" account 
will suffice. Note that when connecting as the "sys" account you will typically need to specify the 
"as sysdba" option. 
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2. Create the database user account by executing the following statement in SQLPlus, replacing 

<username> with the desired database user account name, such as eftuser, and 
<password> with the desired password.  

CREATE USER <username> 
IDENTIFIED BY <password> 
DEFAULT TABLESPACE USERS 
QUOTA UNLIMITED ON USERS 
TEMPORARY TABLESPACE temp QUOTA 5M ON system 
/ 

3. For example: 

 
4. Grant the necessary privileges to the database user account by executing the following 

statements in SQLPlus, replacing <username> with the username of the account you just 
created, such as eftuser. 

GRANT CREATE SESSION TO <username> 
/ 
GRANT CREATE TABLE TO <username> 
/ 
GRANT CREATE TRIGGER TO <username> 
/ 
GRANT CREATE SEQUENCE TO <username> 
/ 
GRANT CREATE PROCEDURE TO <username> 
/ 
GRANT CREATE VIEW TO <username> 
/ 
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5. For example: 

 
6. To exit SQLPlus, type exit and press ENTER. 

Create the Database Objects 
During installation of the EFT Server the installer will place a set of database creation SQL scripts in the 
GlobalSCAPE\EFT Server Enterprise\Oracle subfolder of the system's Program Data folder. (Typically, 
C:\ProgramData\GlobalSCAPE\EFT Server Enterprise\Oracle.) 

The database creation scripts use the "create_#_" filename prefix. The # in the filename represents the 
order in which each script must be executed. 

 
To create the database objects 

1. Using SQLPlus connect to the Oracle database using the EFT Server database user account 
created above. 

 
2. In SQLPlus, execute each database creation SQL Script in the correct order using the command, 

replacing <Script File Path> with the full path and filename of the script.  
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@"<Script File Path>" 

For example: 

 
3. Once you have executed all of the creation scripts you may exit SQLPlus by typing exit and 

pressing ENTER. 

Configure EFT Server 
To configure EFT Server to connect to the newly created database  

• Refer to Audit Database Settings. 

Test Your Connection 
To test your connection 

1. Create a test connection with your FTP client to EFT Server and upload and download a few files. 

2. Using SQLPlus, connect to the Oracle database using the EFT Server database user account. 
For example: 

 
3. Retrieve the number of rows in the TBL_PROTOCOLCOMMANDS table by executing the following 

statement in SQLPlus: 
SELECT COUNT(*) FROM TBL_PROTOCOLCOMMANDS; 
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For example: 

 
The above query should return a count of more than 0.  

4. To exit SQLPlus, type exit and press ENTER. 

5. You can now pull reports directly from EFT Server against data audited to Oracle. 

 

If you are running the administration interface, you must have an entry in that system's DNS for the 
name of the Oracle database computer, otherwise the administration interface will not be able to 
connect to the database when attempting to pull reports. 

ARM Schema 
The tables created during installation are listed below. Because all of EFT Server's modules and features 
are available during the trial, all of the tables below are created, even if you do not activate that 
module/feature. 

tbl_Actions - Logs Actions performed when Event Rules are processed 

ActionID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Actions PRIMARY 
KEY CLUSTERED, 
Time_stamp datetime NOT NULL , 
SiteName nvarchar(50) NULL , 
EventName nvarchar(50) NULL , 
ActionType nvarchar(50) NULL , 
Parameters nvarchar(1000) NULL , 
IsFailedAction bit NULL , 
ResultID numeric(18, 0) NOT NULL , 
EventID numeric(18, 0) NOT NULL , 
TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON 
DELETE CASCADE, 
Details  nvarchar(1000) 

tbl_AdminActions - Logs Actions performed by administrators in EFT Server 
ID numeric(18, 0) IDENTITY(1,1) NOT NULL, 
Timestamp datetime NULL, 
FunctionName nvarchar(200) NULL, 
Action nvarchar(200) NULL, 
AffectedArea nvarchar(200) NULL, 
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AffectedName nvarchar(200) NULL, 
ChangeOriginator nvarchar(200) NULL, 
TransactionID numeric(18, 0) NULL, 
SiteName nvarchar(300) NULL 

tbl_AS2Actions - Contains information about separate Actions for each AS2 transaction: 
ActionID numeric(18, 0) identity 
TransactionID numeric(18, 0) 
ActionStatus numeric(18, 0)   
ActionType numeric(18, 0)   
ErrorCode nvarchar(1000) 
TimeStamp datetime 
FileID numeric(18, 0) 

tbl_AS2Files - Contains information about files transferred via AS2: 
FIleID numeric(18, 0) identity 
TransactionID numeric(18, 0) 
FileName nvarchar(300) 
ContentType nvarchar(50) 
LocalPath nvarchar(300) 
RemotePath nvarchar(300) 

tbl_AS2Transactions - Contains details of AS2 Transactions: 
TransactionID numeric(18, 0) identity 
MIC nvarchar(100)  (EFT Server calculates the AS2 MIC using SHA-1. You can ignore the words 
"MD5" that appear in the MIC column of the AS2-related reports.) 
StartTime datetime 
CompleteTime datetime 
Direction numeric(18, 0) 
MDN text 
MDNSignatureType nvarchar(50) 
MDNType numeric(18,0) 
LocalHost nvarchar(300) 
RemoteHost nvarchar(300) 
TransactionStatus numeric(18,0) 
SiteName nvarchar(300) 
FromAS2ID nvarchar(300) 
ToAS2ID nvarchar(300) 
ErrorCode nvarchar(1000) 
PayloadSignatureType nvarchar(50) 
PayloadEncryptionType nvarchar(50) 
PayloadHeaders text 
MDNAS2MessageID nvarchar(300) 
PayloadAS2MessageID nvarchar(300) 
MDNHTTPResponse text 

tbl_Authentications - Logs authentication attempts for administrators and users per Site 
AuthenticationID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT 
PK_tbl_Authentications PRIMARY KEY CLUSTERED, 
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Time_stamp datetime NOT NULL , 
RemoteIP nvarchar(15) NOT NULL , 
RemotePort numeric(18, 0) NULL , 
LocalIP nvarchar(15) NOT NULL , 
LocalPort numeric(18, 0) NULL , 
Protocol nvarchar(50) NULL , 
SiteName nvarchar(50) NULL , 
UserName nvarchar(50) NULL , 
PasswordHash nvarchar(500) NULL , 
SettingsLevels nvarchar(500) NULL , 
ResultID numeric(18, 0) NOT NULL , 
TransactionID numeric(18, 0) NOT NULL References tbl_Transactions(TransactionID) ON 
DELETE CASCADE 

tbl_ClientOperations - Logs upload/download/create/etc Actions performed by clients (FTP, HTTP, etc) 
ClientOperationID numeric (18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT 
PK_tbl_ClientOperations PRIMARY KEY CLUSTERED , 
Time_stamp datetime NOT NULL , 
Protocol nvarchar(50) NULL , 
RemoteAddress nvarchar(50) NULL , 
RemotePort numeric (18, 0) NULL , 
Username nvarchar(50) NULL , 
RemotePath nvarchar(500) NULL , 
LocalPath nvarchar(500) NULL , 
Operation nvarchar(50) NULL , 
BytesTransferred numeric (18, 0) NULL , 
TransferTime numeric (18, 0) NULL , 
ResultID numeric (18, 0) NOT NULL , 
TransactionID numeric (18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON 
DELETE CASCADE 
LogFileName 

tbl_CustomCommands - Logs details of custom commands being executed.  These are typically 
launched by Event Rules 

CustomCommandID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT 
PK_tbl_CustomCommands PRIMARY KEY CLUSTERED, 
Time_stamp datetime NOT NULL , 
SiteName nvarchar(50) NULL , 
Command nvarchar(50) NULL , 
CommandParameters nvarchar(1000) NULL , 
ExecutionTime numeric(18, 0) NULL , 
ResultID numeric(18, 0) NOT NULL , 
TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON 
DELETE CASCADE 

tbl_EventRules - Logs details of Event Rules that have been processed 
EventID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_EventRules PRIMARY 
KEY CLUSTERED, 
Time_stamp datetime NOT NULL , 
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SiteName nvarchar(50) NULL , 
EventName nvarchar(50) NULL , 
EventType nvarchar(50) NULL , 
ConditionValues nvarchar(1000) NULL , 
TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON 
DELETE CASCADE 
EventGUID numeric(18, 0) NOT NULL 

tbl_Groups - Provides plain text group name for reporting (part of db normalization) 
GroupID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Groups PRIMARY 
KEY CLUSTERED, 
GroupName nvarchar(50) NULL , 
AuthenticationID numeric(18, 0) NOT NULL REFERENCES tbl_Authentications(AuthenticationID) 
ON DELETE CASCADE 

tbl_PCIViolations - Logs PCI violations for PCI DSS compliance testing reports 
PCIViolationID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_PCIViolations 
PRIMARY KEY CLUSTERED, 
Time_Stamp datetime NULL , 
ViolationID int NULL , 
SiteName nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
SettingsLevel nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
UserName nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
Admin nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
Reason nvarchar(500) COLLATE SQL_Latin1_General_CP1_CI_AS NULL 

tbl_ProtocolCommands - Logs detailed client commands sent for various protocols (ftp, http, etc) 
ProtocolCommandID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT 
PK_tbl_ProtocolCommands PRIMARY KEY CLUSTERED, 
Time_stamp datetime NOT NULL , 
RemoteIP nvarchar(15) NULL , 
RemotePort numeric (18,0) NULL , 
LocalIP nvarchar(15) NULL , 
LocalPort numeric (18,0) NULL , 
Protocol nvarchar(50) NULL , 
SiteName nvarchar(50) NULL , 
Command nvarchar(10) NULL , 
CommandParameters nvarchar(1000) NULL , 
FileName nvarchar(500) NULL , 
VirtualFolderName nvarchar(500) NULL , 
PhysicalFolderName nvarchar(500) NULL , 
IsInternal 
FileSize numeric(18, 0) NULL , 
TransferTime numeric(18, 0) NULL, 
BytesTransferred numeric(18, 0) NULL , 
ResultID numeric(18, 0) NOT NULL , 
TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON 
DELETE CASCADE 
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tbl_SAT_Emails - Logs the notification e-mails sent by the SAT module 
ID numeric(18, 0) IDENTITY (1, 1) NOT NULL , 
txid int NOT NULL , 
email nvarchar (80) COLLATE SQL_Latin1_General_CP1_CI_AS NOT NULL , 
emailType int NULL 

"emailType" is a "0" for TO:, "1" for CC:, "2" for BCC: 
tbl_SAT_Files - Logs the files uploaded by the SAT module 

id numeric(18, 0) IDENTITY (1, 1) NOT NULL , 
txid int NOT NULL , 
filename nvarchar (255) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
filesize bigint NULL 

tbl_SAT_Transactions - Audits transactions managed by the Secure Ad Hoc Transfer (SAT) module. 
ID numeric(18, 0) IDENTITY (1, 1) NOT NULL , 
time_stamp datetime NULL , 
fromEmail nvarchar(80) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
subject nvarchar(255) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
body nvarchar(5000) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
tempUserName nvarchar(40) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
siteName nvarchar(80) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
expiryDays int NULL , 
tempPassword nvarchar(80) COLLATE SQL_Latin1_General_CP1_CI_AS NULL, 
transactionGUID uniqueidentifier NULL, 
reserved1 nvarchar(2000) NULL, 
reserved2 nvarchar(2000) NULL 

tbl_Schema_Version - Maintains the current version of the ARM schema 
Id smallint NOT NULL, 
Version nchar(7) NOT NULL 

tbl_ServerInternalEvents 
ServerInternalEventID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT 
PK_tbl_ServerInternalEvents PRIMARY KEY CLUSTERED, 
Time_Stamp datetime NULL , 
SiteName nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
SettingsLevel nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
UserName nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
EventName nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
Parameters nvarchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL 

tbl_SocketConnections - Logs details (ip addresses, port numbers, etc) of individual socket connections 
for various protocols (ftp, http, etc). 

SocketID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_SocketConnections 
PRIMARY KEY CLUSTERED, 
Time_stamp datetime NOT NULL , 
RemoteIP nvarchar(15) NULL , 
RemotePort numeric (18,0) NULL , 
LocalIP nvarchar(15) NULL , 
LocalPort numeric(18, 0) NULL , 
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SiteName nvarchar(50) NULL , 
ResultID numeric(18, 0) NOT NULL , 
TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON 
DELETE CASCADE 

tbl_Transactions - Provides transaction references to correlate data from various ARM tables 
ParentTransactionID numeric(18, 0) NULL REFERENCES tbl_Transactions(TransactionID), 
TransactionObject nvarchar(50) NOT NULL 
TransactionGUID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Transactions 
PRIMARY KEY CLUSTERED , 

(Refer to Result IDs for a description of the Result ID columns that appear in some reports.) 

ARM Database Schema Change Tracking 
The ARM database schema for EFT Server v6.5 has undergone many changes, and each is described 
below. The database version number appears in the installer during upgrade. 

 
When you upgrade from v6.3 or v6.4 to version 6.5, each of the changes, from version 0.0.0.0 to the 
released version, will be made to the database. 

ARM Schema Update Version 0.0.0.0 to 1.0.0.0 

Applies to: SQL Server, Oracle 

Change Type: Multiple, see below for specific changes 

Description: 

This upgrade modifies the tables to use the nchar/nvarchar data type to allow persistence of various 
languages within the database. This upgrade also resolves issues with databases created by earlier 
versions of EFT Server. 
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Converting existing data to the new data types should be considered a significant upgrade process. 
Please consult the EFT Server help topics Upgrading the EFT Server Database and Upgrading Large 
Databases for additional information. 

Note that for the most part the upgrade script may be re-executed multiple times in the case that an error 
must be resolved by manual intervention. 

SQL Server Upgrade 

1. When upgrading databases earlier than EFT Server 6.4, the upgrade process will increase the 
size of the following columns to support storage of IPv6 addresses: 

o tbl_Authentications.RemoteIP 
o tbl_Authentications.LocalIP 
o tbl_ProtocolCommands.RemoteIP 
o tbl_ProtocolCommands.LocalIP 
o tbl_SocketConnections.RemoteIP 
o tbl_SocketConnections.LocalIP 

2. The upgrade will then proceed with changing all char and varchar columns to nchar and nvarchar. 
Be aware that this process drops the majority of the objects (other than the tables) prior to 
converting the data types and then recreates them afterwards. The upgrade uses the following 
process to migrate to the nchar/nvarchar data type: 
a. Drop all stored procedures 
b. Drop all functions 
c. Drop all indexes 
d. Drop all constraints 
e. For each table to be converted: 

i. Verify if the table has already been converted by checking the data type of one of 
the columns to be converted. If it is already nvarchar the table is assumed to 
have been upgraded and is skipped.  

ii. Create a staging table stage_<OriginalTableName> 
iii. In batches of 500,000, insert data from the source table into the staging table by 

selecting batches based on the primary key column 
iv. If no errors occur during the data migration, drop the original table and rename 

the staging table to the original  
f. Recreate the constraints (primary keys and foreign keys) 
g. Recreate the indexes 
h. Recreate the functions 
i. Recreate the stored procedures 

This step also resolves an issue in the sp_GetInboundTransfersInfo stored procedure. In 
earlier versions of the database this procedure was missing an ORDER BY clause. This 
clause is now included in the procedure definition so the issue is resolved when this 
procedure is recreated. 

3. Finally, the upgrade process will create a new View called vw_ProtocolCommands.  

Oracle Upgrade 

1. EFT Server now includes a View in the database. Originally the database account created for use 
by EFT Server did not include the CREATE VIEW privilege. This privilege must be granted to the 
account prior to upgrading to this version of the database. This upgrade will attempt to create a 
test view to ensure the account has the privilege before proceeding further into the upgrade 
process. 

2. When upgrading databases earlier than EFT Server 6.4 the upgrade process will increase the 
size of the following columns to support storage of IPv6 addresses: 

o TBL_AUTHENTICATIONS.REMOTEIP 
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o TBL_AUTHENTICATIONS.LOCALIP 
o TBL_PROTOCOLCOMMANDS.REMOTEIP 
o TBL_PROTOCOLCOMMANDS.LOCALIP 
o TBL_SOCKETCONNECTIONS.REMOTEIP 
o TBL_SOCKETCONNECTIONS.LOCALIP 

3. As of EFT Server 6.5 the original TBL_SCHEMAVERSION table has been deprecated and is 
dropped by the upgrade process if present. 

4. In EFT Server 6.3 the SQL scripts had an issue where the TBL_PCIVIOLATIONS was defined 
twice. Once with the ID column called PCIVIOLATIONID and later with it called 
PCIVIOLATIONSID. Unfortunately this led to some issues down the road. To be consistent with 
the SQL Server table definitions we ultimately need to ensure the column name is 
PCIVIOLATIONID. If the incorrect column name is detected then it is renamed. Note that the 
trigger used to insert the sequence number is dropped and recreated later as part of the Unicode 
upgrade process. Additionally, the table may have been created without the 
PK_TBL_PCIVIOLATIONS primary key. If this is detected then the primary key is created. 

5. Earlier scripts created a table called TBL_ADMINCOMMANDS. This table is not used by EFT 
Server; if detected it is dropped, as is the associated sequence TBL_ADMINCOMMANDS_SEQ. 

6. The upgrade will then proceed with changing all char and varchar columns to nchar and nvarchar. 
Be aware that this process drops the majority of the objects (other than the tables) prior to 
converting the data types and then recreates them afterwards. The upgrade uses the following 
process to migrate to the nchar/nvarchar data type: 
a. Drop all stored procedures 
b. Drop all functions 
c. Drop all indexes 
d. Drop all constraints 
e. For each table to be converted: 

i. Determine if the table has already been converted by checking the data type of 
one of the columns to be converted. If it is already nvarchar, the table is assumed 
to have been upgraded and is skipped. 

ii. Create a staging table STAGE_<OriginalTableName> 
iii. Copy the data into the staging table using an INSERT INTO/SELECT FROM 

statement 
iv. If no errors occurred, drop the original table and rename the staging table to the 

original table name. 
f. Create triggers on each table for id column generation 
g. Recreate the primary keys 
h. Recreate the foreign keys 
i. Recreate the indexes 
j. Recreate the stored procedures 
k. Since the above process drops and recreates many of the database objects, it inherently 

resolves the following problems that may be present in existing databases: 
i. Removes the FK_TBL_ADMINCOMMANDS_TRANSID foreign key if present. 

The corresponding table is no longer used. 
ii. Removes the TBL_ADMINCOMMAND_TRG trigger if present. The 

corresponding table is no longer used. 
iii. Removes the PK_TBL_ADMINCOMMANDS index if present. The corresponding 

table is no longer used. 
iv. Removes the PK_TBL_SCHEMAVERSION index if present. The corresponding 

table is no longer used. 
v. Resolves an issue in the SP_GETINBOUNDTRANSFERSINFO stored 

procedure. In earlier versions of the database this procedure was missing an 
ORDER BY clause. 

vi. Earlier versions of the database may be missing the following indexes, which will 
be created during the upgrade process: 

 IX_TBL_CLIENTOPS_TXNID 
 IX_TBL_AUTH_TIME_STAMP 
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 IX_TBL_CLIENTOPS_TIME_STAMP 
 IX_TBL_CUSCMDS_TIME_STAMP 
 IX_TBL_AUTH_TRANSACTIONID 

7. Finally, the upgrade process will create a new View called vw_ProtocolCommands 

ARM Schema Update Version 1.0.0.0 to 2.0.0.0 

Applies to: SQL Server only 

Change Type: User Account Modification 

Description: 

SQL Server databases created using the EFT Server version 6.3 database creation scripts contained a 
defect in which the EFT Server database user account was created with its default schema set to a non-
existent schema. The schema had the same name as the username. 

Later versions of the EFT Server database creation scripts set the database user account's default 
schema to 'dbo' which is more standard. Additionally, the user account was created as a 'db_owner' 
which results in the various database objects being created in the dbo schema anyway. 

To resolve this inconsistency, this upgrade will determine if the database user account's default schema 
has the same name as the account and if so set the default schema to 'dbo'. 

ARM Schema Update Version 2.0.0.0 to 3.0.0.0 

Applies to: SQL Server only 

Change Type: Stored Procedure Modification 

Description: 

This upgrade recreates the sp_Insert_tbl_Groups stored procedure to resolve an issue in which the 
procedure failed to obtain the newly generated identity value after executing the 
sp_Insert_tbl_Authentications stored procedure. 

ARM Schema Update Version 3.0.0.0 to 4.0.0.0 

Applies to: SQL Server, Oracle 

Change Type: Table Change 

Description: 

This upgrade removes the unused tbl_ResultCodes table. 

ARM Schema Update Version 4.0.0.0 to 5.0.0.0 

Applies to: SQL Server, Oracle 

Change Type: Function Modification, Stored Procedure Modification 

Description: 

This upgrade recreates the f_TransferResult and f_CommandProtocolError functions and the 
sp_GetInboundTransfersInfo procedure to resolve an issue in which aborted transfers were not always 
appearing correctly in the Status Viewer. 

ARM Schema Update Version 5.0.0.0 to 6.0.0.0 

Applies to: None 

Change Type: None 

Description: 
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This upgrade was replaced by a later upgrade and is left as a placeholder to maintain proper versioning. 
This upgrade has no effect on the database. 

ARM Schema Update Version 6.0.0.0 to 7.0.0.0 

Applies to: SQL Server, Oracle 

Change Type: Function Modification, Stored Procedure Modification 

Description: 

This upgrade recreates the f_TransferResult function and the sp_GetInboundTransfersInfo procedure to 
resolve an issue by which finished HTTP/S downloads were not appearing in the Status Viewer or 
reports. 

 

38 



 

Auditing 
These topics provide information about auditing EFT Server activity with the Auditing and Reporting 
module. 

Audit Database Settings 
When you run the Server Setup wizard, you are offered the opportunity to enable auditing and reporting 
and configure the connection information. If you chose to do that later or if you want to edit the database 
information, you can do so on the Logs tab in the Audit Database Settings area. 

To enable and configure auditing and reporting 

1. In the administration interface, connect to EFT Server and click the Server tab. 

2. On the Server tab, click the Server node you want to configure. 

3. In the right pane, click the Logs tab. 

 
4. In the Audit Database Settings area, select the Enable Auditing and Reporting check box to 

enable communication with the database; clear the check box to disable auditing and reporting. 

5. In the Database type area, select SQL Server or Oracle. (Oracle is available in EFT Server 
Enterprise only.) 

6. In the Database host address[\Instance Name] box, specify the host or database instance 
name of the database to which you want EFT Server to connect, or provide a DSN or DSN-less 
connection string.  

7. In the Database Name box, provide the name of the database or leave the box empty if you 
provided a connection string in the Database host address[\Instance Name] box. 
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8. For SQL Server databases, in the Authentication box, specify whether the database is to use 
Windows Authentication or SQL Server Authentication. 

9. In the Database username and Password boxes, provide the username and password needed 
to connect to the database or leave the box empty if you provided a connection string in the 
Database host address[\Instance Name] box or if you are using Windows Authentication. 

10. In the In case of database error area, specify whether you want to audit database errors to a 
folder: 

• If you do want to audit errors, or to stop it temporarily, click Stop auditing. 

• To Audit to folder, click the option, then specify the path to the folder in the box. 

11. In the Failure notification e-mail box, provide the e-mail address that you want to receive error 
notifications in case of database failure. Multiple e-mail addresses must be separated by 
semicolons (;). When auditing is enabled, this e-mail is sent any time that EFT Server cannot 
reach the database. 

12. If you make any changes to the database audit settings, click Apply to save the changes on EFT 
Server. 

13. To verify the connection information, click Test Connection. The status of the database 
connection appears above the Reconnect button. If the database is not connected, click 
Reconnect to reconnect to the database. 

• Test Connection - EFT Server attempts a connection using the supplied parameters 
without applying the changes. 

• Reconnect - EFT Server applies the settings (a prompt appears if you made changes 
and did not click Apply) and attempts to connect to ARM with the new settings. 

Auditing Database Recovery 

 

The SQL statements logged in the text file must be loaded into the database before any reports 
are run. 

If EFT Server is disconnected from the database and is configured to save auditing information to 
the log file, do the following: 

1. Solve the connection problem. 

2. Repair the database, and insert the data from the text file into the database. Be sure to insert the 
data only once, otherwise the auditing data will be corrupted. 

3. In the administration interface, connect to EFT Server and click the Server tab. 

4. On the Server tab, click the Server that you want to configure. 

5. In the right pane, click the Logs tab. 

6. Click Test Connection to test the status of the database connection. (You must click Apply to 
apply any changes first.) 

7. The Connection status area indicates whether EFT Server is communicating with the database. 
To reconnect to the database, click Reconnect. 
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How EFT Server Handles SQL Data 
EFT Server truncates data values within each audited SQL transaction to ensure the data value fits within 
the corresponding database field. 

The special characters (as defined by the SQL interpreter) within each data value of an audit SQL event 
are escaped to ensure the data value is stored and retrieved properly from the database. The following 
special characters are escaped by EFT Server during generation of SQL statements prior to submission 
to the database engine: 

• Single quote - % 

• Open brace - [ 

• Percent - % 

• Underscore - _ 

Auditing Advanced Workflow Engine (AWE) Actions 
(The Advanced Workflow Engine is available in EFT Server Enterprise.) As with other Event Rule Actions, 
Advanced Workflow Actions are audited to the Auditing and Reporting Module (ARM) database. For all 
Event Actions, the following items are audited: 

• Time stamp 

• Site Name 

• Event Name 

• Action Types such as move, copy, OpenPGP, and send e-mail. 

• Action Parameters* - These are runtime values passed to the Action, not the replacement 
variables. 

• Failed Action Flag - This is captured if this Action is the result of a FAILURE sequence on a prior 
Action. 

• Action Result Code 

• Result 

*For AWE Actions, this is the path to the temporary file associated with the Workflow that was 
executed. This file contains more detailed debug logging if enabled for that particular workflow. 

Auditing Administrator Changes to the ARM Database 
(Requires High Security Module in addition to ARM) Administrators often need to know when and 
what changes were made to EFT Server and who made them. The Administrator Actions Log report 
provides information about administrator changes. 

EFT Server logs the following changes made to EFT Server to the ARM database: 

• The Date the action occurred, in MM/DD/YYYY HH:MM:SS format. 

• The affected feature or Function. (Refer to Functions Audited below.) 

• The type of Action (created, added, removed, modified, enabled, disabled, started, and stopped). 

• The Affected Area (Server, Site, Settings Template, User Account, Event Rule, Command, 
Group, VFS, Report). 

• The name of the affected object, Affected Name (Server Name, Site Name, Settings Template 
Name, User or Admin Account Name, Event Rule Name, Command Name, Group Name, Folder 
Name, Report Name). 
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• The name of the administrator that made the change, Change Originator. 

The data in the preconfigured report is arranged in columns, Date, Function, Action, Affected Area, 
Affected Name, and Change Originator, grouped by Site name, and sorted in reverse chronological 
order (newest change at the top). 

 

Functions Audited 
When the following functions are created, added, removed, modified, enabled, disabled, started, or 
stopped, the action is logged to the database. Many possible actions are grouped together. For example, 
modifying SSL cipher selection, changing SSL clear command channel values, or modifying SSL 
connection string all fall under "SSL settings." Also, intermediate states are not audited (e.g., a toggle was 
checked, but later unchecked, rendering the transaction moot). Instead, only committed states are 
captured (once the administrator applies changes). 
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• SFTP protocol 

• SFTP settings 

• SFTP key 
• SFTP authentication 

settings 
• SSL protocol 

• SSL settings 

• SSL require client 
certificate 

• SSL certificate 

• SSL authentication 
settings 

• FIPS mode for SSL 

• FIPS mode for SSH 
• HTTPS protocol 

• HTTPS settings 

• HTTP protocol 
• FTP Implicit Protocol 

• FTP Explicit Protocol 

• FTP protocol 
• FTP settings 

• AS2 protocol 

• AS2 settings 
• PASV port mode settings 

• Streaming repository 
encryption (EFS) 

• OpenPGP settings 

• Open PGP key 
• Web Transfer Client 

• Password 

• Password complexity 

• Password reset 
• Password expiration 

• Password History 

• Password initial reset 
• Invalid login settings 

• Inactive account settings 

• Account expiration settings 
• Connection limits 

• Transfer limits 

• Disk limits 
• File type limits 

• IP address ban list 

• Group assignment 
• Group (Permission) 

• Data sanitization (wiping) 

• DMZ Gateway 
• DMZ Gateway settings 

• Authentication settings 

• Remote administration 
• Auditing settings 

• Log settings 

• Default Configuration File 
Path 

• Default User Database 
Refresh Interval 

• SMTP settings 

• DoS prevention settings 

• Delegated 
Administrators 

• Server 
• Site 

• Settings Template 

• User Account 
• Real-time monitoring 

• User kicked 

• Web Services Interface 
• Site root folder 

• Site listening IP 

• Custom command 
• Event Rule 

• Physical folder 

• Virtual folder 
• Folder permissions 

• Administrator 

• Database refresh 
• Server service settings 

• Show Time In 
UTC/GMT 

• Ban On Invalid Login 
Settings 

• AWE Task 
• Account details 

  

Purging Data from the Database 
Space requirements for transactions in the ARM Database depend on the estimated EFT Server activity, 
number of users, and installed modules. A general estimate is 3MB to 5MB of per 1000 files uploaded. A 
minimum of 3GB hard drive space is recommended for the initial database size, with additional space 
required for growth over time. For more detailed information on sizing estimates, refer to Knowledgebase 
article #10684: How much disk space should I allocate for the Auditing and Reporting module (ARM)? 

A good database maintenance plan is important for keeping space requirements to a minimum. Such a 
plan should include periodic archiving or purging of older database. Users should follow standard SQL 
Server/Oracle tuning guidelines provided in the database vendor documentation to maintain a healthy 
database. 

The following procedure describes how to use the provided SQL script to purge older data from the EFT 
Server ARM database. The script allows for customization of the following parameters: 

• The age of data to be purged. The script purges all transactions earlier than the desired data. By 
default, the script will purge all data older than 60 days. 
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• The number of transactions to delete at one time - By default the script will attempt to remove 
older transactions in "chunks" of 100,000 rows. If purging from an active database, it may be 
necessary to purge the records in smaller "chunks" such as 10,000 or 1,000 so as to not 
adversely affect the responsiveness of database for new transactions. The chunk size should be 
adjusted based on the load of the system at the time of purging and the average amount of data 
being purged. 

Purge Script 
Database-specific purge scripts are installed with the EFT Server. By default, the scripts will be under the 
"SQL Server" and "Oracle" sub-directories of the EFT Server Application Data Path. By default the 
Application Data Path will be "C:\Documents and Settings\All Users\Application Data\GlobalSCAPE\EFT 
Server Enterprise" or "C:\Documents and Settings\All Users\Application Data\GlobalSCAPE\EFT Server 
Enterprise" on Windows 2008. 

It is recommended that the purge script be configured and run on a periodic basis to ensure the database 
size does not grow uncontrollably. The script may be run manually or automatically using the operating 
system scheduler, scheduling functionality within the database, or using a Scheduler (Timer) Event within 
the EFT Server. It may be useful to add the script execution as an additional step to the default "Backup 
and Cleanup" Scheduler (Timer) Event in EFT Server. 

SQL Server Purge Script 
The default SQL Server purge script is <EFT>\SQL Server\PurgeSQLEFTData.sql.   

1. If you need to change the database name, "chunk" size, or age at which to purge transactions, 
make a copy of the script, open the script in a text editor, and then edit the following values: 

a. If the database name is not EFTDB, modify the following line with the name of the 
database: 

USE EFTDB 

For example, if your database name is "EFTDB_001" you would change the line to: 
USE EFTDB_001 

b. To change the "chunk" size from the default value of 100,000, modify the following line 
with the desired chunk size: 

EXEC sp_PurgeEFTTransactions NULL, NULL, 100000, 1 

For example, if you wish to purge in chunks of 10,000, you would change the line to: 
EXEC sp_PurgeEFTTransactions NULL, NULL, 10000, 1 

c. By default, the script will purge all transactions older than 60 days. To specify an 
alternate age, modify the following line with the desired age by dates: 

SET @stopTime = DATEADD(DAY, -60, GETDATE()) 

For example, if you wish to purge transactions older than 30 days, you would change the 
line to: 

SET @stopTime = DATEADD(DAY, -30, GETDATE()) 

2. Save your changes to the file. 

3. Use a command line tool such as "oSQL" to connect to the database and execute the script. The 
example below assumes you have kept the same name for the file. 

a. Open a command prompt (click Start > Run, type cmd, then press ENTER). 

b. Type the following to execute the SQL script: 
<PATH>\oSQL.exe -S [server address] -U [username] -P [password] -i 
"<PATH>\PurgeSQLEFTData.sql" 
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For example, type: 
"C:\Program Files\Microsoft SQL Server\80\Tools\Binn\oSQL.exe" -S 
192.168.19.17 -U iuser -P asd123!f$s1 -i "C:\Documents and 
Settings\All Users\Application Data\GlobalSCAPE\EFT Server 
Enterprise\SQL Server\PurgeSQLEftData.sql" 

For additional information on the oSQL utility, including common script samples, refer to osql Utility on 
microsoft.com. 

Oracle Purge Script 
The default Oracle purge script is <EFT>\Oracle\PurgeOracleEFTData.sql. 

1. If you need to change the "chunk" size or age at which to purge transactions, make a copy of the 
script, open the script in a text editor, and then edit the following values: 

a. To change the "chunk" size from the default value of 100,000, modify the following line 
with the desired chunk size: 

CALL sp_PurgeEFTTransactions(NULL, NULL, 100000, 1); 

For example, if you wish to purge in chunks of 10,000, you would change the line to: 
CALL sp_PurgeEFTTransactions(NULL, NULL, 10000, 1); 

b. By default, the script will purge all transactions older than 60 days. To specify an 
alternate age, modify the following line with the desired age by dates: 

pEndTime := sysdate - 60; 

For example, if you wish to purge transactions older than 30 days, you would change the 
line to: 

pEndTime := sysdate - 30; 

2. Save your changes to the file. 

3. Use a command-line tool such as "sqlplus" to connect to the database and execute the script. 
(sqlplus.exe may be obtained by installing the Oracle Data Access Components (ODAC) on the 
system at which the script will be executed. sqlplus.exe may require your tnsnames.ora file to 
be properly configured to connect to the EFT Server database. The example below assumes you 
have kept the same name for the file.) 

a. Open a command prompt (click Start > Run, type cmd, then press ENTER). 

b. Type the following to execute the file: 
<PATH>\sqlplus.exe <EFT>/<EFT>@<EFT> 

For example, type: 
"C:\app\Administrator\product\11.2.0\client_1\sqlplus.exe" iuser/ 
asd123!f$s1@EFTDB 

c. The sqlplus console starts. At the prompt type the following, then press Enter: 
@<PATH>\PurgeOracleEFTData.sql 

For example, type: 
@C:\MyScripts\PurgeOracleEFTData.sql 

For additional information on the sqlplus utility refer to SQL*Plus User's Guide and Reference on 
oracle.com. 
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Result IDs 
The ARM captures the following transaction information from EFT Server, which can appear in reports: 

Actions 

ResultID Description Result Const 
0 If the Event Action is successfully 

executed 
EAR_SUCCESS 

1 If the Event Action fails EAR_FAIL 

2 If STOP Processing this rule is 
selected as Action. 

EAR_STOP_RULE 

4 If STOP processing more rules is 
selected as Action 

EAR_STOP_ALL 

  

 

Stop processing this rule and Stop processing more rules can be combined, in which case the 
value is the sum of the two individual values, that is, 6. 

SocketConnection 

ResultID Description Result Const 
0 When socket successfully created ER_NONE 

8 Per Site socket connection limit 
exceeded 

ER_CONNECT_FAILED_TOO_MANY_CONNECTIONS_PER_SITE 

9 Max connections per IP address 
limit exceeded 

ER_CONNECT_FAILED_TOO_MANY_CONNECTIONS_PER_IP 

10 EFT Server denied the connection 
because the IP address was in the 
ban list or it is a remote IP address 
and EFT Server is in developer 
mode 

ER_CONNECT_FAILED_RESTRICTED_IP 

11 EFT Server denied the connection 
(failed) and added the IP address to 
the auto-ban list 

ER_CONNECT_FAILED_BANNED_IP 

Authentications 

ResultID Description Result Const 
0 Authentication successful LR_OK 

1 Incorrect password LR_PASSWORD_NOT_ACCEPTED 

2 If user account is disabled LR_ACCOUNT_DISABLED 

3 Max connections per Site limit 
exceeded 

LR_TOO_MANY_CONNECTIONS_PER_SITE 

4 Max connections per user 
limit exceeded 

LR_TOO_MANY_CONNECTIONS_PER_USER 

5 User per- IP address 
connection limit exceeded 

LR_TOO_MANY_CONNECTIONS_PER_IP 

6 If given protocol is not 
supported 

LR_PROTOCOL_NOT_SUPPORTED 

7 Connection on restricted IP 
address 

LR_RESTRICTED_IP 

8 If service is unavailable LR_SERVICE_UNAVAILABLE 
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ClientOperations 

ResultID Description Result Const 
1 If copy/move/download 

operation is successful 
TRUE 

0 If copy/move/download 
operation fails 

FALSE 

CustomCommands 

ResultID Description Result Const 
0 Command executed 

successfully 
CER_OK 

1 Command executed with 
socket output 

CER_SYNC 

2 Access is denied CER_ACCESS_DENIED 

3 Command is not found CER_COMMAND_NOT_FOUND 

4 Could not launch the selected 
process 

CER_PROCESS_FAILED 

5 Command is disabled CER_COMMAND_DISABLED 

6 Errors in parameters passed to 
the custom command 

CER_ERROR_IN_PARAMS 

ProtocolCommands 

ProtocolCommands are the same as FTP result codes. Below is a brief general description. 

ResultID Description 
1xx Expected another reply before proceeding with a new command 

2xx Requested action completed successfully 
3xx On hold pending receipt of further information 

4xx Temporary failure 

5xx Permanent failure 

Auditing Database Errors and Logging 
EFT Server detects errors that occur while trying to connect to the ARM database and can detect errors 
returned from the database while attempting to perform transactions. If an error is detected while 
connecting to the database or when performing a transaction on the database (SQL INSERT, UPDATE, 
etc.) you can configure EFT Server to log the error to a file and to send a notification to a specified e-mail 
address. 

By default, database errors are logged to C:\Documents and Settings\All Users\Application 
Data\Globalscape\EFT Server Enterprise\SQL Server\Logs\ or EFT Server Enterprise\SQL 
Server\Logs\, in the format EFT_ARM_<YYYY_MM_DD_HH_MM_SS>.sql. You can specify a different 
path or choose not to log the errors to a file. On Windows 2008, Application Data files for all users are in a 
hidden folder named %systemroot%\ProgramData instead of under Documents and Settings\All 
Users\Application Data. 

 

For details of the Log Settings area, refer to Log Settings. 

EFT Server also generates a Windows Event Log entry when there is an ARM database error. The log 
entry indicates whether auditing has stopped or if the auditing data is being stored to a log file. 
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If database access is lost because of a connection error or transaction error (INSERT or UPDATE), 
resumption of auditing to the database requires a restart of EFT Server or a RECONNECT request by the 
administrator. If EFT Server is configured to stop auditing, the administrator must repair the database, 
and then restart EFT Server or use RECONNECT to resume auditing to the database. 

Logging to a Text File 
In the In case of database error area of the Server's Logs tab, you can configure EFT Server to log the 
SQL statements to a text file. EFT Server continues to use the text file until either EFT Server is restarted 
or until a RECONNECT request is made by the administrator. EFT Server then notifies you by e-mail that 
the logging has been saved to the text file. You can then repair the database, resume auditing to the 
database, and load the recorded text file SQL statements into the database. To ensure the completeness 
of the audit data, the SQL statements in the text file must be loaded into the database before executing 
reports over the time that SQL transactions were logged to the text file. 

If you click Reconnect to resume auditing to the database, and EFT Server is recording auditing 
information to the text file, EFT Server continues to log EFT Server file transfers and/or user sessions that 
are in progress to that text file. New file transfers and new user sessions will continue to be logged in the 
database, but any in-process transfers/user sessions are logged to the text file to ensure that they can be 
inserted and linked appropriately in the database. 

Refer to Audit Database Settings for information about configuring the connection information on EFT 
Server's Logs tab. 
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Reporting 
The Auditing and Reporting module provides numerous predefined reports which you can use as is, 
edit to your needs, or use as templates to create new reports. You can also define custom reports 
using the built-in Report Designer. 

Descriptions of Preconfigured Reports 
The Auditing and Reporting module comes with a number of preconfigured reports that allow you to start 
analyzing data right away. The report templates are .xml files and are installed in 
%systemroot%\ProgramData\Globalscape\EFT Server Enterprise\Reports or \EFT Server\Reports. 
If you plan to edit the default templates, it is a good idea to save a backup of them first. (Note: On 
Windows Server 2003 and earlier, the files are in ..\Documents and Settings\All Users\Application 
Data\Globalscape\EFT Server Enterprise\Reports or \EFT Server\Reports.) You can also use these 
reports as templates to create your own custom reports. 

The preconfigured reports can be used as is or edited to suit your needs for: 

• Billing: If you need to bill your customers for file transfer services and need to supply accurate 
reports to customers and for your own invoicing purposes, these reports allow you to query and 
produce reports based on multiple criteria such as a specific client, a group of clients or all clients, 
a particular date range, and a specific file or all files transferred for that user. 

• Non-repudiation: If you need to audit transactions throughout their life cycle and determine 
whether a particular Event occurred and when it occurred, these reports allow you to search for 
all activity for a specific user for a specific date or to locate a transaction within a date range for 
auditing purposes, and allow you to show conclusively whether something happened, when it 
happened, and who was responsible for making it happen. 

• Statistics: Gathering statistical data allows you to take preventive measures (such as scale to 
meet increasing demand), to establish trends, create general usage reports for stakeholders, and 
to query and analyze trends and server usage (peak usage times, most active customers, etc.). 

• Technical troubleshooting: Granular auditing of all socket, protocol, authentication, and 
transaction information allows the administrator to quickly locate and solve problem scenarios. 

The preconfigured reports described below are provided with the Auditing and Reporting module. You 
can run the reports as is or edit them to suit your specific needs. 

• Activity-Ad Hoc (Detailed) - This report displays activity for ad hoc file transfer activity, sorted by 
date in reverse chronological order. If a user sent multiple files on one e-mail, each file is listed in 
the report. (For Mail Express reports, the Temporary User Name column is blank.) 

• Activity-Ad Hoc (Summary) - This report displays all ad hoc file transfer activity, grouped by 
username, and sorted by date in reverse chronological order. If a user sent multiple files on one 
e-mail, each file is listed in the report. (For Mail Express reports, the Temporary User Name 
column is blank.) 

• Activity-Ad Hoc by File (Detailed) - This report displays all ad hoc file transfer activity for a 
specified file name, and sorted by date in reverse chronological order. If a user sent multiple files 
on one e-mail, each file is listed in the report. (For Mail Express reports, the Temporary User 
Name column is blank.) 

• Activity-Ad Hoc By Recipient (Detailed) - This report displays all ad hoc file transfer activity for 
a specified recipient's e-mail address, and sorted by date in reverse chronological order. If a user 
sent multiple files on one e-mail, each file is listed in the report. When you click Show Report, the 
Enter Report Parameters dialog box appears. Provide the entire e-mail address. (For Mail 
Express reports, the Temporary User Name column is blank.) 
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• Activity-Ad Hoc by Sender (Detailed) - This report displays all ad hoc file transfer activity for a 
specified sender's e-mail address, and sorted by date in reverse chronological order. If a user 
sent multiple files on one e-mail, each file is listed in the report. When you click Show Report, the 
Enter Report Parameters dialog box appears. Provide the entire e-mail address. (For Mail 
Express reports, the Temporary User Name column is blank.) 

• Activity - All File Transfers - This report displays all file transfers as server, client, and LAN-
copy event. Displays date and time, target path, account, direction, IP address, size in KB, code, 
and result (success/failure). 

• Activity - All File Transfers (as Server) - This report displays all file transfers as server. 

• Activity - All Groups (Detailed) - This report displays the various Actions performed by all the 
groups, such as Administrator, All users, and Guests, and it displays Date/Time, Remote IP 
address, protocol, Action, filename, folder, bytes transferred, and the result. 

• Activity - All Users (Summary) - This report displays the transfer activity (total number of 
uploads and downloads) for all users who logged on to EFT Server during the date range 
specified, grouped by username, subgrouped by date, sorted by username, then transfer 
direction, and date, in ascending order. 

• Activity - All Users (Detailed) - This report displays all folders and files created and the delete 
activity for all users who logged on to EFT Server during a particular period, grouped by 
username, and sorted in reverse chronological order. The report includes the time stamp, remote 
IP address of the user, protocol, Action, file name, folder, KB transferred, and the result. 

• Activity - By File - This report displays all the activities related to a specified file, based on 
wildcard masks, grouped by Site name, subgrouped by matching filename, sorted in 
chronological order. The report displays the time stamp, user name, remote IP address, and 
protocol. To generate this report, you have to specify the report parameters, such as .txt to view 
only txt files or *.* to view all files. 

• Activity - By Group (Detailed) - This report displays the folder and file create and delete activity 
during a specified period for a specific group, grouped by group name, and sorted by date in 
reverse chronological order. The report displays the remote IP address, protocol, Action, time 
stamp, file name, folder, bytes transferred, and result. When you click Show Report, the Report 
Parameters dialog box appears asking for the group name. 

• Activity - By User (Detailed) - This report displays the folder and file create and delete activity 
during a specified period for a specific user, grouped by username, and sorted by date in reverse 
chronological order. When you click Show Report, the Report Parameters dialog box appears 
asking for the name of the user. 

• Activity - By User (Detailed) - Group by Username-Action - This report displays the folder and 
file create and delete activity during a specified period for specific users, grouped by username, 
subgrouped by Action, and sorted by date in reverse chronological order. That is, the report 
displays all files created under the Created Action and all files that are sent are displayed under 
the Sent Action. When you click Show Report, the Report Parameters dialog box appears 
asking for the name of the user. 

• Activity - By User (Summary) - This report displays the transfer activity for specifics users, 
grouped by username, subgrouped by date, sorted by username, transfer direction, and date, in 
descending order. 

• Admin Actions - (Requires High Security Module in addition to ARM) This report displays all 
EFT Server administrator activity for the specified range. Columns displayed in the report and 
available report filters include Date/Time (Timestamp), Function (e.g., User Account, Site, 
Database Refresh, SMTP Settings), Action (e.g., Created, Enabled, Disconnected, Modified, 
Started, Renamed), Affected Area (e.g., User Account, Site, Server, Administration), Affected 
Name (username), ChangeOriginator (administrator username), SiteName (e.g., MySite).  
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• Admin Activity (Summary) - This report displays all administrative connections (successes and 
failures) to EFT Server. 

• AS2 Transactions Detailed - A verbose AS2 file transfer report that provides the information 
necessary for troubleshooting problem transactions.  

• AS2 Transactions Overview - A transaction report that displays the same information as shown 
on the Transfers - AS2 node. The report queries all AS2 transactions for the dates specified, 
grouped by site, sorted by date, and listed in reverse chronological order. 

• Event Rules - Actions (Summary) - This report summarizes all Event Rules with their 
corresponding Actions, grouped by Site name, subgrouped by the user-defined Event name, 
sorted by the unique Event ID (not shown in report) in descending order.  

• Event Rules - Activity (Detailed) - This report displays the Event Rule activity by user-defined 
Event name, grouped by Site name, subgrouped by the Event type, sorted by date in reverse 
chronological order. 

• Event Rules - Activity (Summary) - This report summarizes the Event Rule activity by user-
defined Event name, grouped by Site name, sub-grouped by the Event type, sorted by date in 
reverse chronological order. 

• Event Rules - Inbound-Outbound By Date - This report details all offload and download 
Actions, grouped by Site subgrouped by Action, sorted by date in reverse chronological order. 

• Event Rules - Inbound-Outbound By User - This report details all offload and download 
Actions, grouped by Site name, then by remote host IP address, then by username, sorted in 
reverse chronological order. 

• Executive Summary Report - This report summarizes the following information for the period 
specified: 

o Average transfer speed 

o Total number of downloads, uploads 

o Total bytes transferred (inbound/outbound) 

o Top 5 users (by # of connections) 

o Top 5 users (by bytes transferred) 

o Most concurrent users at any given time 

• Security - Failed Logins - This report displays the number of users who could not connect to 
EFT Server. It displays the user name, remote IP address, protocol used, date, time, remote IP 
address, port number, and result.  

• Traffic - Average Transfer Rates by User - This report displays the average transfer rate for 
specific users, grouped by username, subgrouped by date, sorted by username, transfer 
direction, and date, in descending order. 

• Traffic - Connections Summary - This report details connections to EFT Server (IP address or 
user connections) and bytes transferred by date, grouped by Site name, sorted by date in reverse 
chronological order.  

• Traffic - Datewise-Hourly Bytes Transferred - This report details the connections and bytes 
transferred sorted by date and hour, in chronological order. 

• Traffic - Datewise-IPwise bytes transferred - This report displays the connections established 
by remote IP addresses and total bytes transferred.  

• Traffic - IPwise Connections (Summary) - This report displays the connections established by 
remote IP addresses and total bytes transferred. 
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• Traffic - Monthwise-IP-wise Bytes transferred - This report displays the connections 
established by various remote IP addresses each month. It displays the Site name, month name, 
remote IP address, connections, and total bytes transferred. 

• Traffic - Most Active IPs - Connections - This report displays the most active IP addresses; that 
is, the IP addresses of the users who frequently log on to EFT Server. It displays the data 
transferred, Site name, remote IP address, and bytes transferred. This report can be used to 
determine Denial of Service (DoS) attacks against EFT Server. 

• Traffic - Most Active IPs - Data Transferred - This report displays the IP addresses of users 
who log on to EFT Server frequently; the number of connections established by various users. It 
displays the information on the total bytes transferred, number of connections, remote IP address, 
and Site name. 

• Traffic - Most Active Users - Connections - This report displays the connections established by 
the most active users. 

• Traffic - Most Active Users - Data Transferred - This report displays the usernames of users 
who log on to EFT Server frequently, the number of connections established by various users, 
and number of bytes transferred. 

• Traffic - Protocolwise Connections (Summary) - This report displays the connections 
established by various users and the protocol used by the users to transfer the data, that is, 
whether the users have used FTP, HTTP, or any other protocol to upload or download the files.  

• Traffic - Sitewise-Hourly by User - This report displays the total number of connection 
established by various users on a particular Site each hour.  

• Troubleshooting - Connection Errors - This report displays the number of connection errors 
occurred while connecting to a site. 

• Troubleshooting - Event Rules Failures - This report displays failures related to the Event 
Rules. 

• Troubleshooting - IP Address Activity (Detailed) - This report displays the details of the user, 
the date/Time on which the user logged on EFT Server; other details such as local port, socket 
result ID, protocol, password, physical folder name, virtual folder name, and so on are also 
displayed. To view this report, you must specify the IP address in the Enter Report Parameters 
dialog box that opens when you click Show Report.  

• Troubleshooting - Operation Errors - This report displays protocol error codes and 
corresponding commands, sorted in reverse chronological order. The report includes the date 
and time the error occurred, remote IP address, protocol used, username, command, filename, 
virtual folder, and result (e.g., transfer completed).  

• Web Service- Invoke Event Rules (Detailed) - This report is used to view detailed activity for 
invoking Event Rules through Web Service, grouped by username, and sorted by date in reverse 
chronological order. 

(Refer to Winsock Error Codes for a list of Socket ID error codes.) 
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Generating a Report 
The ARM comes with a number of preconfigured reports to help you start analyzing data right away. The 
built-in reports were designed to respond to the most common data analysis requests. Refer to 
Preconfigured Reports for a list of available reports. 

 

If you are using SQL Express as your database, you may not be able to generate a report 
remotely, unless the connecting account is a trusted SQL Server connection (e.g., if SQL Server 
and the remote computer are in the same domain, or if SQL Server is configured to allow "mixed 
authentication.") 

To generate a report 

1. In the administration interface, connect to EFT Server and the reports database, and then click 
the Reports tab. 

2. In the left pane, click the desired report. 

3. In the right pane, specify any filters. 

4. Specify a date range from which you want pull data. 

5. Type the appropriate parameters/wildcards for the search if the following reports are used: 

• Activity By File - Type the file name. 

• Activity By Group - Type the group name. 

• Troubleshooting IP address Activity - Type the IP address. 

6. Click Show Report. The ARM connects to the auditing database and displays the data in the 
right pane. 

 

ARM displays the first page of the report as soon as the data is ready, then continues to load 
additional pages. You can monitor the progress of loading by watching the current page/total 
pages indicator on the report filter bar. 
 

 
 
If you want to stop a report from loading, click another report in the left pane. 

Using Report Filters 
You can filter the fields in a report based on various conditions to display only the data that meet the 
filtering criteria. 

The Report Filters area contains two sets of combo boxes, operands (AND, OR), and a text box. 

 
Use the second set of filters to further define the report using AND or OR. 
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For example, suppose you have generated a report like the one below: 

 
To show only changes made by TommyToad and June.Bug, set the following filters: 

1. In the first combo box, click Change Originator. 

2. In the second combo box, click the equals sign ( = ). 

3. Type June.Bug in the text box. 

4. Click OR. 

5. In the bottom filter, click Change Originator, equals, and type TommyToad. 

 
6. Specify a date range, and then click Show Report. 

7. The report now displays only changes made by administrators TommyToad or June.Bug. 
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(If you had clicked AND instead of OR, nothing would appear, because no changes can be made 
by 2 administrators at the same time.) 

Defining Custom Reports 
These topics provide information regarding creating custom reports of EFT Server activity in the 
administration interface. 

VSReport Designer 
Ad hoc querying, sorting, filtering, and reporting can be accomplished by editing one of the existing 
reports or creating a new report in the provided report editor. This tool can be launched from the Windows 
Start menu or from within the administration interface. 

The report editor tool bundled with ARM is a robust report designer licensed from Component One. 
During EFT Server evaluation period, VSReport Designer is available for use as a fully functional 30-day 
trial. A license for VSReport Designer is included with each purchase of ARM. After the 30-day trial, ARM 
must be activated along with EFT Server to continue using VSReport Designer. Most of the main 
functions of the report designer are described in this help file; however, the VSReport Designer has its 
own Help file, accessed by clicking Help on the report designer's the main menu. 

In VSReport Designer, you can work on existing report templates, change field locations and properties, 
add various levels of grouping, sorting, and so on. You can also create new reports and select ARM’s 
database tables from which to retrieve data fields or paste in SQL code for advanced queries of the data 
source, giving customers complete freedom in designing their report. Styles for the report (colors, fonts, 
background logo images, etc.) can all be manipulated from within the designer. You can also 
import report definitions from Microsoft Access files (MDB, ADP) and VSReport Designer files (VSR) from 
within the Report Designer. 

 

Translation of Access reports requires that Microsoft Access is installed. Once the report is 
imported into the Designer, Access is no longer required. 
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The main Designer dialog box includes the following: 

• Report list - The left pane of the Report Designer lists all report templates contained in the 
current report definition file. (A report can contain multiple report templates.) You can double-click 
a report name to preview or edit the report. You can also right-click in the list to rename, copy, 
and delete report templates. 

• Preview/Design pane - The right pane is the main working area of VSReport Designer. In 
preview mode, it displays the current report. In design mode, it shows the report's sections and 
fields and allows you to change the report definition. 

• Main Menu - The main menu is used to access submenus, load and save report definition files, 
import report definitions, and print reports. 
 

 
• Shortcut toolbar - Shortcuts are used to access the most common menu functions: new file, 

open, import, save, print, undo/redo, cut/copy/paste, create/delete report, and help. 
 

 
• View toolbar - The View toolbar allows you to easily switch between preview and design modes, 

activate the design grid, and display the property and grouping panes. 
 

 
• Toolbox - The Toolbox provides tools for creating report fields. This toolbar is enabled only in 

design mode. 
 

 
• Formatting toolbar - The Formatting toolbar provides shortcuts to tools for aligning, sizing, and 

spacing report fields. This toolbar is enabled only in design mode. 
 

 
• Status bar - The Status bar at the bottom of the Report Designer displays information about 

what VSReport Designer is working on (e.g., loading, saving, printing, rendering, importing, etc.). 
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Opening VSReport Designer 
When you create a new report, you create it manually or use the Report Wizard. Both methods are 
provided in the VSReport Designer, as described below. 

To open VSReport Designer 

1. In the administration interface, connect to EFT Server, then do one of the following: 

• On the toolbar, click the click New Report icon . 

• On the main menu, click Reports > New Report. 

• Click the Reports tab, and then click the New Report icon. 

The New Report dialog box appears. 
 

 
2. Type a title for the new report, and then click Create. The Report Designer appears. 

 

 
3. Do one of the following to create a report: 

• Manually define the report: click the Design icon , then continue with the instructions 
in Using Design Mode, Changing Field, Section, and Report Properties, Changing the 
Data Source, Adding, Editing, and Deleting Fields in the Report, and Grouping and 
Sorting Data. 

• Use the Report Wizard: In the Report Designer, click File > New Report or click the 
New Report  icon on the toolbar. 
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Creating a Report with the Report Wizard 
The easiest way to start a new report is to use the Report Wizard. The Report Wizard will help you create 
a basic report, specify the data source, fields to include in the report, layout of the report, and styles or 
labels to use in the report. 

To use the Report Wizard 

1. In the administration interface, connect to EFT Server, then do one of the following: 

• On the toolbar, click the click New Reports icon . 

• On the main menu, click Reports > New Report. 

• Click the Reports tab, and then click the New Reports icon on the bottom toolbar. 

The New Report dialog box appears. 
 

 
2. Type a title for the new report, and then click Create. The Report Designer appears. 
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3. Click File > New Report or click the New Report  icon on the toolbar. The New Report 
Wizard appears. 
 

 
4. By default, the ConnectionString box displays information for the database that you specified 

when you installed the Auditing and Reporting module. Click Next and go to step 5 or, if 
necessary, you can type a different string that is used to connect to the data source.  

a. Click to define the connection string. The Data Link Properties dialog box appears. 

b. On the Provider tab, click Microsoft OLE DB Provider for SQL Server as the provider 
to connect to the SQL Server database, and then click Next. The Connection tab 
appears. 

c. In Select or enter a server name, click the arrow to select a name or type the name of 
EFT Server. 

d. In Enter information to log on to EFT Server, click an authentication option to log on to 
EFT Server: 

 Use Windows NT Integrated security - Your computer automatically picks up 
the credentials from your computer and connects you to the database. 

 Use a specific user name and password - Specify the user name and the 
password to be used to log on to EFT Server. Select the Allow saving 
password check box to save the password in the connection string. 

 

Select the Blank password check box if EFT Server requires a blank 
password to log on the database server. Even if you do not type any 
password when you create a user account on a database server, you can 
select the Allow saving password check box. In this case, EFT Server 
takes a dummy password value and saves that value in the connection 
string. Selecting the Blank password check box disables the password 
field. 

e. Click one of the following: 

 Select the database on EFT Server, and then click a database in the list. 

 Attach a database file as a database name - Click the ellipsis icon to browse 
for the SQL Server database file (*.mdf). The Select SQL Server Database File 
dialog box appears. Select a file, then click Open. The path to the file appears in 
the Using the filename box. 
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f. Click OK in the Data Link Properties dialog box to return to the New Report Wizard. 

5. Click one of the following: 

• Table to select a database table, such as tbl_EventRules. 

• SQL Statement to type a SQL query in the bottom box, such as SELECT * FROM 
tbl_EventRules. 

6. Click Next. The fields that appear in the Available list depend on your selection in the previous 
step. For example, if you selected tbl_EventRules, the fields for Event Rules appear. 

 
7. Click Next. The fields that appear in the Available list depend on your selection in the previous 

step. For example, if you selected tbl_EventRules, the fields for Event Rules appear. 
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8. Double-click a field, click it and use the arrows, or drag and drop one or more field to the Groups 
list. Group fields define how the data is sorted and summarized. The information in the Detail list 
is grouped according to the group name. The Detail list displays the details for each group. Detail 
fields define the information you want to appear in the report. For example, if you move SiteName 
to the Groups list and Time_stamp, EventName, and so on to the Detail list, then the report 
displays the time stamp and events under the respective Sites, considering different Sites as 
different groups. 

 

You can also drag and drop the available fields into the Groups or Detail section. 

9. Click Next. The layout options appear. 

 
10. Click a layout for the report. When you select a layout, a thumbnail preview appears on the left to 

give you an idea of how the layout will appear on the page. There are two groups of layouts. The 
first is for the reports with no groups defined and other is for the reports with group fields defined. 

• If you did not define the Group field, the following options are available: 

 Columnar 

 Tabular 

 Justified 

 Labels. The Labels layout option is used to print Avery-style labels, available in a 
variety of sizes, blank or preprinted. If you select this option, the next page offers 
options for the type of label for your report. 

• If you defined the Group field, the following options are available: 

 Stepped 

 Outline 

 Aligned 

11. If you selected any option other than Labels, click the report orientation from the following 
options. If you select the Labels option, the Orientation options are disabled. 

• Portrait 

• Landscape 

12. Select the Adjust fields to fit page check box to adjust fields in a way that they fit the page. 

13. Click Next. 
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14. Do one of the following: 

• If you specified Labels, click a type of label in the Labels list, then specify the Units, 
Metric or English, and the paper type, Sheet Feed (single sheet) or Continuous 
(continuous paper). 

 
• If you specified anything other than Labels, specify a style for the report title. 

 
15. Click Next. 
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16. Type a title for the report. 

17. Do one of the following: 

• To view the report, click the Preview the report. 

• To modify the report in Design view, click the Modify the report's design. 

18. Click Finish. Your new report name appears in the left pane of the Report Designer. The right 
pane displays a preview of the report or the design view, depending on your selection in the 
previous step. 

19. Click Save to save the report. 

20. Click File > Close to close VSReport Designer. The report appears on the Reports tab. 

21. Use Design mode to add/remove fields, resize fields, add graphics, and so on. 

Creating a Report in Design Mode 
The New Report Wizard is used to specify a data source and a basic framework for the report. To get 
exactly the report you want, you can adjust and enhance the data fields and layout. The Report Designer 
provides the options to modify the report to fit your needs. 

To use the Report Designer design mode 

1. In the administration interface, click the Reports tab, then do one of the following: 

• Click the report that you want to modify, and then click Edit Report. 

• Create a new report. (Refer to Creating a Report with the Report Wizard for instructions.) 

The report appears in the Report Designer. 
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2. The left pane of the Report Designer lists all report templates contained in the current report 
definition file. Click the report that you want to modify, and then click the Design  icon on the 
View toolbar, or on the main menu, click View > Design. The right pane switches from Review 
mode to Design mode, and displays the controls and fields that make up the report. 
 

 

The Report Sections 

The report is divided into sections, labeled Header, Page Header, Detail, and Page Footer, containing 
fields that hold the labels, variables, and expressions that you want in the generated report. The sections 
determine the appearance of the beginning and end of the report, and each page and group. The table 
below describes where each section appears in the report and the sort of data that typically appears in 
each section. 

Section Appears Typically Contains 
Report Header Once per report The report title and summary information for the whole report 

Page Header Once per page Labels that describe detail fields and/or page numbers 

Group Header Once per group Fields that identify the current group and possibly aggregate values 
for the group (e.g. total, percentage of the grand total) 

Detail Once per record Fields containing data from the source record set 

Group Footer Once per group Aggregate values for the group 

Page Footer Once per page Page number, page count, date printed, report name 

Report Footer Once per report Summary information for the entire report 

You cannot directly add and delete sections. The number of groups determines the number of sections in 
a report. Each report has exactly five fixed sections (Report Header/Footer, Page Header/Footer, and 
Detail) plus two sections per group (a Header and a Footer). 

To hide sections that you do not want to display 

1. Right-click the field, click Properties. The Field Properties dialog box appears. 

2. Change the property of Visible to False. 
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To resize a section 

1. Click and hold the border of the section and drag it to the position where you want it. 
 
The rulers on the left and on top of the design dialog box show the size of each section (excluding 
the page margins). You cannot make the section smaller than the height and width required to 
contain the fields in it. To reduce the size of a section beyond that, move or resize the fields in the 
section first, then resize the section. 

2. Press and hold SHIFT, and then click fields to toggle their selection status. 

3. Press and hold CTRL, then drag the cursor to copy a selection. 

4. Click on the corners of a field to resize it. 

5. Press TAB to move the selection to the next field. 

6. Press the arrow keys to move selected fields. 

7. Press DELETE to remove selected fields. 

 

If you make any mistakes while moving or editing the fields, click Undo and/or Redo . 

When multiple fields are selected, you can use the buttons on the Format toolbar to align, resize, and 
space them. 

 
You can control the design grid using the Show Grid   and Snap To Grid   icons. 

Changing Field, Section, and Report Properties 
You can view and edit the properties of the objects inserted in a report. 

• When more than one field is selected, the Field Properties dialog box displays only the 
properties and values that all selected fields have in common and leaves the other properties 
blank. 

• If no fields are selected and you click a section (or on the bar above a section), the selected 
section's properties are displayed. 

• If you click the gray area in the background, the Report properties are displayed. 

To view and edit an object's properties 

• Double-click the object or select the object, then do one of the following: 

o Click Property Window. 

o Press F4 

o Right-click, and then click Properties. 

The Field Properties dialog box appears. 
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In the example below, the Activity - All Group (Detailed) label in the Header section is selected. The 
Field Properties dialog box displays the properties of the selected field. 

 
In the Field Properties dialog box, you can change a property by changing its value. For example, you 
can change the text color by changing the ForeColor property. You can change the field's position and 
dimensions by typing new values for the Left, Top, Width, and Height properties. 

The property dialog box expresses all measurements in twips (the native unit used by the ComponentOne 
report designer), but you can type in values in other units and they will be automatically converted into 
twips. For example, if you set the field's Height property to "0.5in," the property dialog box will convert it 
into 720 twips. 

Changing the Data Source 
The data source is defined when you installed the ARM database. If you have more than one data source 
available, you can specify a different source.   

To change the data source for a report 

1. View the report in Design mode . 

2. Click the DataSource icon . The wizard appears. 
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• The title bar displays the name of the report. 

• The ConnectionString box is populated with the string that was defined when you 
installed ARM (e.g., 
"provider=sqloledb;server=K2003VM\GLOBALSCAPE;database=EFTDB;Trusted_Conne
ction=yes;"). 

• The box below the ConnectionString displays the table or SQL Statement used to 
populate the report. 

3. To specify a different data source, click the browse icon . The Data Link Properties dialog 
box appears. 

 
4. In the OLE DB Provider(s) list, click the data source server (e.g., Microsoft OLE DB Provider 

for SQL Server), and then click Next. The Connection tab appears. 
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5. In the Select or enter a server name box, click the down arrow, and then click the database 
host\instance name. If the server you want does not appear in the list, click Refresh. (If you still 
do not see the ARM database server, verify EFT Server's connection to the database on the 
Server's Logs tab.) 

6. In the Enter information to log on to the server area, do one of the following: 

• Click use Windows NT Integrated security. The system will use the logged-in user's 
account for database connections. 

• Click Use a specific user name and password, then specify the username and 
password. 
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7. In the Select the database on the server box, click the down arrow and select the ARM 
database name. 

 
8. Click OK. The wizard displays the data from the specified source. 

9. Click OK to close the data source wizard. 
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Adding, Editing, and Deleting Fields in the Report 

 
Use the ToolBox to add fields to your report. VSReport Designer only has one type of field object; the 
icons in the Toolbox simply set the properties of the field to make it look and act in a certain way. Each 
icon creates a field and initializes the field's properties as follows: 

Icon Name Description 

 

Label field Creates a field that displays static text. 

 

Bound field Creates a field that is bound to the source recordset. When you click this button, a 
menu appears and you can select the recordset field. Bound Fields are not limited 
to displaying raw data from the database. You can edit their Text property and use 
any VBScript expression. 

 
Expression 
Field 

Creates a calculated field. When you click this button, the code editor dialog will 
appear so you can enter the VBScript expression whose value you want to display. 

 
Check box 
Field 

Creates a bound field that displays a Boolean value as a check box. By default, the 
check box displays a regular check mark. You can change it into a radio button or 
cross mark by changing the value of the field's Checkbox property after it has been 
created. 

 

Unbound 
Picture field 

Creates a field that displays a static picture, such as a logo. When you click this 
button, a dialog box will appear to prompt you for a picture file to insert in the report. 
A copy is made of the picture you select and is placed in the same directory as the 
report file. You must distribute this file with the application unless you embed the 
report file in the application. When you embed a report file in your application, any 
unbound picture files are embedded too. 

 

Bound 
Picture field 

Creates a field that displays a picture (or object) stored in the recordset. When you 
click this button, a menu appears so you can select a picture field in the source 
recordset (if there is one; not all recordsets contain this type of field). 

 

Line field Creates a line. Lines are often used as separators. 

 

Rectangle 
field 

Creates a rectangle. Rectangles are often used to highlight groups of fields or to 
create tables and grids. 

 

Subreport 
field 

Creates a field that displays another report. When you click this button, a menu 
appears and you can select other reports that are contained in the same report 
definition file. 

 
Page Break 
field 

Creates a field that inserts a page break. 

After you click any of these icons, drag the mouse over the report and the cursor will change into a 
crosshair. Click and drag to define a space that the new field will occupy, and then release the button to 
create the new field. If you change your mind, press ESC or click the arrow button to cancel the 
operation. 

You can also add fields by copying and pasting existing fields, or by holding down the control key and 
dragging a field or group of fields to a new position to create a copy. 

To add, edit, or delete fields in a report 

1. In the Report Designer, click View > Design or click the Design icon  on the toolbar. The 
report opens in the design mode. 

2. Follow the procedures below depending on the fields that you want to add, edit, or delete. 

To draw a line 

• Click Line , then drag the cursor where you want to draw a line. 
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To draw a rectangle 

• Click Rectangle , then drag the cursor where you want to draw a rectangle. 

To add or edit text 

1. Insert a rectangle, or double-click or right-click an existing rectangle, and then click Properties. 
The Field Properties dialog box appears. 
 

 
2. Scroll to Text in the Property column, click the Value column, then type the text; press ENTER. 

To add labels 

• Click Label , then drag the pointer to draw a box in the report at the place you want to add a 
label. Name the label, then specify its font, color, and other properties. You can click and drag the 
label to adjust its placement in the report. 

To add data fields 

• Click Data field , then draw a box on the report. Change the properties of the data field by 
right-clicking it, and then clicking Properties. 
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To create a VBScript expression 

1. Click Calculated field  on the toolbar. The VBScript Editor appears. 
 

 
2. Type the VBScript expression. For example, type: 

=count (Transaction ID) 

3. Click OK. 

4. Drag the pointer and place it under the respective field where you want the result to display. 

5. Click the Preview icon on the toolbar to view the result. 

To insert images 

1. Click Picture . The Open dialog box appears. 

2. Click an image, and then click Open. 

3. Drag the cursor to draw a box where you want the image to appear. 

To delete fields 

• Click the field, then press DELETE. 

Grouping and Sorting Data 
After designing the basic layout, you may decide to group the records by certain fields or other criteria to 
make the report easier to read. Grouping allows you to separate groups of records visually and display 
introductory and summary data for each group. The group break is based on a grouping expression. This 
expression is usually based on one or more recordset fields, but it can be as complex as you like. 

Groups are also used for sorting the data, even if you do not plan to show the Group Header and Footer 
sections. 

The bar across the top of each section (Page Header, Group Header, Detail) contains some useful tools 
and information about the section. 

 
The indented box with a minus sign  or a plus sign  to the left of the section is used to collapse and 
expand the section. This feature is useful when you are designing the report to allow you to see a group's 
header and footer on the same screen without scrolling. Collapsing or expanding a section has no effect 
on how it is rendered in the report. 
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• An indented circle  indicates that the section currently has zero height. You can drag the 
divider line down to increase the section's Height property. 

• The triangle  to the left of Group Header indicates the group's sorting order. You can click this 
icon to open the Sorting and Grouping dialog box. 

• The labels to the right of the icons are the section name and, for group headers, the value of the 
group's GroupBy property (in this example, Country). 

To add, edit, reorder, or delete groups in the report 

1. Click the Sorting and Grouping icon , click View > Grouping Window, or click the triangle  
to the left of the group header. The Sorting and Grouping dialog box appears. 

2. Use this dialog box to create, edit, reorder, and delete groups. 
 

 
To create a new grouping condition 

1. In the Group On column, click an empty row and type a name. For complex grouping, type an 
expression instead of a simple field name. For example, you could use "Country" to group by 
country or "Left(Country, 1)" to group by country initial. 

2. In the Sort column, click the arrow to select the sort order you want to use for grouping the data 
(Ascending, Descending, or None). 

3. In the Header, Footer, and Keep Together columns, specify whether the new group will have 
visible Header and Footer sections, and whether the group should be rendered together (No, 
With first detail, or Whole Group) on a page. 

 

You cannot use memo or binary (object) fields for grouping and sorting. This is a limitation 
imposed by OLEDB. 

4. After you enter some data for the first group, a new blank row is appended to the list, so you can 
keep creating new groups. If you add more groups, you can change their order by clicking on the 
left-most gray cell in the row and dragging the row to a new position. This will automatically adjust 
the position of the Group Header and Footer sections in the report. 

5. To delete a field in the group, select it, then press DELETE. 

6. Click OK. The changes appear in the Designer. 
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Example: Creating a Custom Report 
In this example, we will use the Report Wizard to create a custom Administrator Actions report sorted by 
Site Name, like one shown below. The example assumes you have installed ARM with SQL Server 
Express and have performed administrator actions in EFT Server, such as creating users, 
stopping/starting sites, and so on. (The High Security Module (HSM) is required for Admin Actions 
reporting.) 

To create the report 

1. In the administration interface, connect to EFT Server, then do one of the following: 

• On the toolbar, click the click New Report icon . 

• On the main menu, click Reports > New Report. 

• Click the Reports tab, and then click the New Report icon on the bottom 
toolbar. 

The Create New Report dialog box appears. 

 
2. Type a title for the new report, and then click Create. The Report Designer appears. 

So far, all you have done is opened the VSReport Designer, which allows you to open the New 
Report Wizard, which we will do next. You will delete this "template" later. 

3. Click File > New Report or click the New Report   icon on the toolbar. The New Report 
Wizard appears. 

 
4. By default, the ConnectionString box displays information for the database that you specified 

when you installed the Auditing and Reporting module. Click Next and go to step 5 or, if 
necessary, you can type a different string that is used to connect to the data source.  

a. Click to define the connection string. The Data Link Properties dialog box appears. 

b. On the Provider tab, click Microsoft OLE DB Provider for SQL Server as the provider 
to connect to the SQL Server database, and then click Next. The Connection tab 
appears. 
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c. In Select or enter a server name, click the arrow to select a name or type the name of 
EFT Server. 

d. In Enter information to log on to EFT Server, click an authentication option to log on to 
EFT Server: 

 Use Windows NT Integrated security - Your computer automatically picks up 
the credentials from your computer and connects you to the database. 

 Use a specific user name and password - Specify the user name and the 
password to be used to log on to EFT Server. Select the Allow saving 
password check box to save the password in the connection string. 

 

Select the Blank password check box if EFT Server requires a blank 
password to log on the database server. Even if you do not type any 
password when you create a user account on a database server, you can 
select the Allow saving password check box. In this case, EFT Server 
takes a dummy password value and saves that value in the connection 
string. Selecting the Blank password check box disables the password 
field. 

e. Click one of the following: 

 Select the database on EFT Server, and then click a database in the list. 

 Attach a database file as a database name - Click the ellipsis icon to browse 
for the SQL Server database file (*.mdf). The Select SQL Server Database File 
dialog box appears. Select a file, then click Open. The path to the file appears in 
the Using the filename box. 

f. Click OK in the Data Link Properties dialog box to return to the New Report Wizard. 

5. Click Table, then click tbl_AdminActions. 

 
6. Click Next. The fields that appear in the Available list are from the table you selected in the 

previous step. 
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7. Click and drag SiteName to the Groups field, then click and drag each of the other fields, except 

ID and Transaction, into the Detail box. (If you click the right-facing arrows, every field will move 
to the Detail area. Then you can individually move back the fields you do not want.) 

 
8. Click Next. The layout options appear. 

9. Keep the default settings and click Next until you get to the last step. (For details of using the 
report wizard to define layout options, refer to Creating a Report with the Report Wizard. For this 
example, we use the default options.) 
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10. Type a title for the report, and then click Finish. 

• The left pane of the Report Designer displays the report's name (and the report template 
that was created in step 2). 

• The right pane displays a preview of the report. 

• The title bar displays the name of the report and an asterisk, indicating that you have not 
yet saved the report. 

11. Let's get rid of that "new" template that was created when you opened the VSReport Designer. In 
the left pane, click the name of the template you want to remove, and then click the delete icon  
on the toolbar. 

12. Click File > Save or click the Save icon on the toolbar. 

13. Click File > Exit to close VSReport Designer. The report appears in the tree on the Reports tab. 

14. In the right pane, click Show Report. The report appears in the preview pane. 
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You can filter the results, such as show results only for certain Sites, a specific administrator 
account, or a certain date. 

15. Click Save As to save the report. The report displays EFT Server administrator actions sorted by 
Site Name and Server. 
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Managing Reports 
These topics provide information regarding managing the reports of EFT Server activity. 

Saving a Report 
You can save reports to a file and export them in the following formats: HTML (.htm), VSPrinter (.vp), 
Portable Document Format (.pdf), Rich-Text Format (RTF), or plain text (.txt). (See Exporting and 
Publishing Reports in the Report Designer for a description of the various formats.) 

To export a report 

1. In the administration interface, connect to EFT Server and the reports database, and click the 
Reports tab. 

2. With the report displayed in the right pane, click File > Save As. 

3. In the Save as dialog box, specify the format and location to save the report. 

Exporting Reports in XML Format 
You can save the reports in XML format, and they can be imported in that format. 

To export the report 

1. In the administration interface, connect to EFT Server and click the Report tab. 

2. In the left pane, click the report. 

3. On the main menu, click Reports > Export Report or right-click the report and click Export 
Report. The Save As dialog box appears. 

4. Specify a name (if you want to save it with a different name) and a location to save the report, 
and then click Save. 
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Exporting and Publishing Reports in the Report Designer 
Instead of printing the report, you may want to export it into a file and distribute it electronically to your 
clients or coworkers. VSReport Designer supports several export formats, listed below: 

Format Description 
Paged HTML Creates one HTML file for each page in the report. The HTML pages contain links that let 

the user navigate the report. 

Drill-Down HTML Creates a single HTML file with sections that can be collapsed and expanded by the user 
by clicking on them. 

Plain MILT Creates a single, plain HTML file. 

PDF Creates a PDF file that can be viewed on any computer equipped with Adobe's Acrobat 
viewer or browser plug-ins. 

VSPrinter Creates a file using the VSPrinter control's native format. The file can be loaded, viewed, 
and printed from a VSPrinter control within an application or Web page. 

Text Creates a plain text file. 

To create an export file 

1. In the administration interface, connect to EFT Server and click the Reports tab. 

2. In the left pane, click the desired report. 

3. In the right pane, click Edit Report . The report opens in the Report Designer. 

 
4. In the left pane of the Report Designer, click the report that you want to export. 

5. On the File menu, click Export. The Save As dialog box appears. 

6. Specify the type of file you want to create, its name (if you want to give it a different name), and 
its location, then click Save. 
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Importing Reports 
You can add reports to EFT Server by importing the XML reports from the local drive to EFT Server. 

To import reports into EFT Server 

1. In the administration interface, connect to EFT Server and click the Reports tab. 

2. On the main menu, click Report > Import or right-click the Reports node and click Import from 
the shortcut menu. The Open dialog box appears. 

 
3. Click the XML file you want to import, and then click Open. 

4. The report is added in the left pane under Reports. 

Deleting a Report 
You can delete any reports that you no longer use. You cannot recover the report unless you previously 
exported and saved it. 

To delete reports 

1. In the administration interface, connect to EFT Server and click the Reports tab. 

2. In the left pane, click the report, then do one of the following: 

• On the main menu, click Reports > Delete Report. 

• Right-click the report and click Delete Report. 

• Click Remove . 

A confirmation message appears. 

3. Click Yes to delete the report. The selected report is deleted. 

Saving Report Outputs 
The report can be saved HTML, PDF, and XML. 

To save reports in different formats 

1. In the administration interface, connect to EFT Server and click the Reports tab. 

2. In the left pane, click the report, then do one of the following: 
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• On the main menu, click Reports > Save Report As. 

• Right-click the report, and then click Save Report Output As. 

The Save As dialog box appears. 
 

 
3. Navigate to the folder in which you want to save the report. 

4. In the File name box, type a name for the report. 

5. In the Save as type box, click a format, and then click Save. 

Renaming a Report 
You can rename the preconfigured reports and your custom reports. 

To rename a report 

1. In the administration interface, connect to EFT Server and click the Reports tab. 

2. Click Edit Report . 

The report designer appears. 
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3. In the left pane of the report designer, click the report name to make it editable, type your 

changes, then press ENTER or click away from the edit box. 

4. On the toolbar, click the Save icon , then close the Report Designer. 

 

The new name does not immediately update in the Reports tree of the administration 
interface. If you double-click the report in the tree, the name will update. 
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